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The information provided in this documentation contains general descriptions and/or 
technical characteristics of the performance of the products contained herein. This 
documentation is not intended as a substitute for and is not to be used for 
determining suitability or reliability of these products for specific user applications. It 
is the duty of any such user or integrator to perform the appropriate and complete 
risk analysis, evaluation and testing of the products with respect to the relevant 
specific application or use thereof. Neither Schneider Electric nor any of its affiliates 
or subsidiaries shall be responsible or liable for misuse of the information that is 
contained herein. If you have any suggestions for improvements or amendments or 
have found errors in this publication, please notify us. 

No part of this document may be reproduced in any form or by any means, electronic 
or mechanical, including photocopying, without express written permission of 
Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when 
installing and using this product. For reasons of safety and to help ensure 
compliance with documented system data, only the manufacturer should perform 
repairs to components.

When devices are used for applications with technical safety requirements, the 
relevant instructions must be followed. 

Failure to use Schneider Electric software or approved software with our hardware 
products may result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

© 2012 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.
33003885 07/2012 5



PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction 
and operation of electrical equipment and its installation, and has received safety 
training to recognize and avoid the hazards involved.
6 33003885 07/2012



About the Book
At a Glance

Document Scope

This documentation describes the operating mode specifics of Unity Pro XLS 
Software for programming safety projects with Quantum Safety PLCs.

For detailed information on safety please refer to the Modicon Quantum Safety 
Reference Manual.

This documentation is intended for qualified personnel familiar with functional safety 
and with the Unity Pro software.

Commissioning and operating the Quantum Safety PLC may only be performed by 
persons who are authorized to commission and operate systems in accordance with 
established safety standards.

Validity Note

This documentation is valid from Unity Pro 7.0.

Unity Pro XLS Software is used to program safety and also non-safety (standard) 
projects. For standard (non-safety) features please refer to the standard Unity Pro 
Software Operating Modes Manual.

Related Documents

Title of Documentation Reference Number

Modicon Quantum Safety Reference Manual 33003879

Unity Pro Safety Block Library 33003873

Unity Pro Operating Modes Manual 33003101

Unity Pro Languages and Program Structure, Reference Manual EN 35006144

Modicon Quantum Automation Series, Hardware Reference Guide 35013379

Quantum Instruction Sheets 33002365 -RL

Quantum Discrete and Analog I/O Reference Guide 33002447
33003885 07/2012 7



You can download these technical publications and other technical information from 
our website at www.schneider-electric.com.

Product Related Information

User Comments

We welcome your comments about this document. You can reach us by e-mail at 
techcomm@schneider-electric.com.

IEC 61131-2 Programmable controllers Part 2: Equipment 
requirements and tests, Second edition 2003-02

–

IEC 61508 Functional safety of electrical/electronic/programmable 
electronic safety-related systems, edition 2.0

–

IEC 61511 Functional safety - safety instrumented systems for the 
process industry sector, First edition

–

WARNING
UNINTENDED EQUIPMENT OPERATION

Use only Schneider Electric approved software.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION

Refer to IEC 61508, "Functional safety of electrical/electronic/programmable 
electronic safety-related systems".
Completely understand the applications and environment defined by Safety 
Integrity Level (SIL) 3 within IEC 61508 Parts 1-7, edition 2.0.
SIL requirements are based on the standards current at the time of certification.
Do Not exceed SIL3 ratings in the application of this product.
The terms safety application, safety project and safety PLC as used in this 
document are applied only within the SIL3 rating.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
8 33003885 07/2012
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Unity Pro XLS Software Safety 
Application Specifics, Context 
Help
Overview

This part contains descriptions for the menus and dialog boxes of Unity Pro XLS.

What Is in This Part?

This part contains the following chapters:

Chapter Chapter Name Page

1 General Presentation of Unity Pro XLS Software 11

2 Global Project Management for Unity Pro XLS Software 13

3 Project Properties and Password for Unity Pro XLS Software 41

4 Network Configuration with Unity Pro XLS Software 53

5 Programming with Unity Pro XLS Software 57

6 Project Configuration with Unity Pro XLS Software 71

7 Debugging the Program with Unity Pro XLS Software 83
9
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General Presentation of 
Unity Pro XLS Software
Capabilities of Unity Pro XLS Software with Quantum Safety PLCs

Overview

Unity Pro XLS Software is used to program safety and also non-safety (standard) 
projects.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

The following documentation applies to Unity Pro XLS Software projects working 
with Quantum safety PLCs.

Hardware Platforms

Unity Pro XLS Software working with Quantum safety PLCs supports the following 
hardware platform:

Quantum Safety

Programming Languages

Unity Pro XLS Software provides the following programming languages for creating 
a safety program:

Function Block Diagram (FBD)
Ladder Diagram (LD) language

No other programming languages are allowed.

These two programming languages can be used together (see page 58) in the same 
safety project.

Safety Block Library

The blocks that can be used to program a safety project are included in the Safety 
block library of Unity Pro XLS.

For a better overview the library is broken down into families.

The blocks can be used in the programming languages FBD and LD.
11



General Presentation of Unity Pro XLS Software
Elements of a Program

A safety program only allows sections (see page 61) in the master (MAST) task 
(see page 58).

Performance Scope

The following table shows the available features of the Unity Pro XLS Software 
software when programming safety projects: 

Legend:
+ = available
- = not available

Programming languages

Function Block Diagram (FBD) +

Ladder Diagram (LD) language +

Libraries

Safety library +

General information

Create and use data structures (DDTs) -

Create and use Derived Function Blocks (DFBs) +

Project browser with structural and/or functional view +

Managing access rights +

Operator screen +

Diagnostic viewer +

System diagnostics +

Project diagnostics -

Application converter -

Managing multi-stations -

Supported platforms

Quantum Safety 140 CPU 651 60S
140 CPU 671 60S

Openness

Hyperlinks +

Unity Pro Server for OFS, UDE
Unity Pro Server for UAG

+ (with write restrictions)
-

Documentation as context help and PDF +

OS Loader tool +

Unity Loader -
12 33003885 07/2012
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Global Project Management for 
Unity Pro XLS Software
Overview

This chapter describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to global project management.

What Is in This Chapter?

This chapter contains the following sections:

Section Topic Page

2.1 Security Management and Self-Test for Unity Pro XLS 
Software

14

2.2 Programming Environment Check with Unity Pro XLS 
Software

16

2.3 Project Management for Unity Pro XLS Software 22
13



Project Management Unity Pro XLS Software
2.1 Security Management and Self-Test for Unity Pro 
XLS Software

Security Management for Unity Pro XLS Software

Overview

Features of the Access Security Management of standard Unity Pro XL Software 
are available.

The current rules to help protect a tool from unauthorized usage are applied. It is in 
the responsibility of systen designers, programmers and users to use the security 
management to activate the protection.

For detailed information on security management please refer to the standard 
Unity Pro XL Software documentation.

New Product in the Security Editor

In the Security Editor, on the user information tab, Unity Pro XLS Software will be 
added to the list of products.

For Unity Pro XLS Software, like the other products on the Security Editor list in the 
Security editor, you can apply a policy, create profiles and users.

For detailed information please refer to the standard Unity Pro XL Software 
documentation.

Access Rights

Unity Pro XLS Software provides the same access rights as Unity Pro XL Software 
plus some new ones for the special needs of safety environment. 

The following new access rights are introduced:
create or modify application password (please refer to Protection of a Safety 
Project with Unity Pro XLS Software, page 44)
enter maintenance mode (please refer to Maintenance Mode with Unity Pro XLS 
Software, page 29)
adapt auto-lock timeout (please refer to Protection of a Safety Project with 
Unity Pro XLS Software, page 44)
14 33003885 07/2012



Project Management Unity Pro XLS Software
Log Information

Security editor log information is managed by the Microsoft Windows Event Viewer.

If you want to display the log information you must launch the event viewer. Here 
you can filter according to the server sequential events.

You can use the event viewer functions, like sort, filter etc.

For further information please refer to Event Viewer (Microsoft Windows), page 20.
33003885 07/2012 15



Project Management Unity Pro XLS Software
2.2 Programming Environment Check with Unity Pro 
XLS Software

Overview

This section describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to programming environment checks.

For detailed information please refer to the Quantum Safety PLC Safety Manual, 
section Checking the Programming Environment (see Modicon Quantum, Quantum 
Safety PLC, Safety Reference Manual).

What Is in This Section?

This section contains the following topics:

Topic Page

Unity Pro XLS Software Self-Test 17

Event Viewer (Microsoft Windows) 20
16 33003885 07/2012



Project Management Unity Pro XLS Software
Unity Pro XLS Software Self-Test

At a Glance

Unit Pro XLS provides a self-test to verify that the components currently in use are 
the correct versions originally installed and are not corrupted, e.g. by a hard disk 
failure.

When performing the self-test, Unity Pro XLS Software checks the version and CRC 
of: 

the safety-relevant DLLs,
the safety FFB library database and
the safety subset of the hardware catalog database.

For detailed information please refer to the Quantum Safety PLC Safety Manual, 
section Checking the Programming Environment (see Modicon Quantum, Quantum 
Safety PLC, Safety Reference Manual).

Check of DLLs

This check helps to ensure the integrity of the Unity Pro XLS Software.

Safety Library Check

For verifying the physical integrity of the safety library, a CRC check is performed on 
the libset.db and the object-code files of the safety library.

Hardware Catalog Check

This check helps to ensure the integrity of the safety subset of the hardware catalog 
including safety hardware (physical integrity).
33003885 07/2012 17



Project Management Unity Pro XLS Software
Performing the Self-Test

To perform the self-test proceed as follows:

Step Action

1 Open the About dialog box via Help → About Unity Pro XLS Software.
Result:
18 33003885 07/2012



Project Management Unity Pro XLS Software
2 Click the Perform Self-Test button.
Result:
The Unity Pro XLS Software Self-Test dialog box opens and the self-test is 
carried out without any additional interaction. 
The dialog box shows the results of the test.

3 Click the OK button.
Result:
If any of the checks failed the Severe warning ! dialog box opens.

4 Click the OK button to confirm the warning.
Note:
Be aware that it is now in your responsibility to solve the identified problems.

Step Action
33003885 07/2012 19



Project Management Unity Pro XLS Software
Event Viewer (Microsoft Windows)

Overview

Events logged by Unity Pro XLS Software can be displayed in the Event Viewer of 
Microsoft Windows.

Unity Pro XLS Software enters some additional messages to the event viewer not 
known by a non-safety Unity Pro (e.g. when switching the PLC to maintenance 
mode).

The event viewer is not mandatory for safety applications. 

It is an additional feature but it is not required by IEC 61508 to use it.

Launching the Event Viewer

To launch the event viewer proceed as follows:

Setting the Filter

To set the filter proceed as follows:

Step Action

1 Launch the Event Viewer via Start → Settings → Control Panel → 
Administrative Tools.

2 Select Application in the structural view on the left side.

Step Action

1 Open the filter dialog via View → Filter.

2 For Source set TraceServer.
20 33003885 07/2012
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3 For Category set Security.
Result:
Only messages of Unity Pro XLS Software are displayed.

Step Action
33003885 07/2012 21



Project Management Unity Pro XLS Software
2.3 Project Management for Unity Pro XLS Software

Overview

This section describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to safety project management.

For standard (non-safety) features concerning project management please refer to 
the standard Unity Pro XL Software documentation.

What Is in This Section?

This section contains the following topics:

Topic Page

Creating a Safety Project with Unity Pro XLS Software 23

Opening a Safety Project with Unity Pro XLS Software 25

Safety Mode with Unity Pro XLS Software 27

Maintenance Mode with Unity Pro XLS Software 29

Switching Between Safety and Maintenance Mode 30

Monitoring Mode 33

Connecting To A Safety PLC 34

Connecting to the PLC Simulator 36

Transferring a Safety Project to a Safety PLC 37

Transferring a Safety Project from a Safety PLC 38

Starting and Stopping a Safety Project 39
22 33003885 07/2012



Project Management Unity Pro XLS Software
Creating a Safety Project with Unity Pro XLS Software

Overview

Unity Pro XLS Software manages safety projects.

By selecting a safety PLC a project will become a safety project.

A safety project is automatically password protected. By default an empty password 
is set and is a valid one.

NOTE: Schneider Electric strongly recommends you to change the default 
password immediately after having selected a Quantum safety PLC in order to help 
protect your project against unauthorized access from the beginning. If you forget to 
change the default password, the empty password is kept if you save and close your 
project.

For further information please refer to Protection of a Safety Project with Unity Pro 
XLS Software, page 44.

Creating a Project

To create a new safety project, carry out the following actions:

Step Action

1 Click the New command in the File menu.
Result: The New Project dialog box is displayed.
33003885 07/2012 23



Project Management Unity Pro XLS Software
2 To see all PLC versions, click on the box Show all versions.

3 Select a Quantum safety CPU.
Result: Your project automatically becomes a safety project and Unity Pro XLS Software sets an empty 
password by default to help protect it.
NOTE: An empty password doesn’t protect a project.

4 Select the processor you wish to use from those proposed.

5 To create a project with specific values of project settings, check the box Settings File and use the 
browser button to localize the .XSO file (Project Settings file). It is also possible to create a new one.
If the Settings File box is not checked , default values of project settings are used.

6 Confirm with OK.

Step Action
24 33003885 07/2012



Project Management Unity Pro XLS Software
Opening a Safety Project with Unity Pro XLS Software

Overview

If you select a project file (*.STU) in the Open dialog box the Project information 
field shows the Type of the PLC. 

The S at the end of the type name indicates a safety PLC (e.g. 140 CPU 671 60S).

To open a safety project requires Unity Pro XLS. If you try to open a safety project 
with another Unity Pro version, a warning message is shown and opening will be 
unsuccessful.

A safety project is automatically password protected. By default an empty password 
is set and is a valid one. If the empty password is set you can just click OK. 
Otherwise you must enter the correct password and confirm with OK.

For further information please refer to Protection of a Safety Project with Unity Pro 
XLS Software, page 44.

Opening a Project

To open an existing project, carry out the following actions:

Opening a project also restores the Unity Pro context, which was saved when the 
project was closed. This involves

the list of open tools,
for each tool: its window’s size, position, contents and animation status,
taskbar and tool configuration.

The context file is a companion file to the <Project_name>.STU file. It is saved in the 
same directory with the name <Project_name>.CTX.

NOTE: When a project file is selected, the software provides a certain amount of 
information: the project name, associated comment, version and date the project 
was generated, PLC targeted by the project, and date of last modification to the 
source code.

Step Action

1 Choose the Open command from the File menu.

2 Select the file related to the project (file *.STU).

3 Confirm with Open.
Result: The Application Password dialog box is displayed.

4 Type your password and confirm with OK or, if you did not assign a password 
yet, just click OK.
Result: Unity Pro XLS Software opens your project.
33003885 07/2012 25



Project Management Unity Pro XLS Software
NOTE: The STU file is a work file and it cannot be used to switch from one version 
to another of Unity Pro software. In this case, you should use the export function in 
the project and create an XEF file or use the archive format (STA file).
26 33003885 07/2012



Project Management Unity Pro XLS Software
Safety Mode with Unity Pro XLS Software

Overview

Quantum safety PLCs can run projects in two different modes:
safety mode
maintenance mode

The functions available in Unity Pro XLS Software depend on the current mode of 
the PLC to which Unity Pro XLS Software is connected.

Safety mode means that the Unity Pro XLS Software is connected to a safety PLC, 
which is running a project in safety mode. 

Maintenance mode means that Unity Pro XLS Software is connected to a safety 
PLC, which is running a project in maintenance mode.

For detailed information please refer to the Quantum Safety PLC Safety Manual, 
section Operating Procedures (see Modicon Quantum, Quantum Safety PLC, 
Safety Reference Manual).

Restrictions in Safety Mode

In Unity Pro XLS Software the safety mode is entered when connecting to a safety 
PLC running in safety mode or when the mode of a connected PLC is switched from 
maintenance mode to safety mode.

In safety mode the following functions of Unity Pro XLS Software are not available:
download changes
forcing of variables (even for animation tables and operator screens)
modification of variables (even for animation tables and operator screens)
debugging mode
setting a breakpoint
setting a watch point
upload
transferring data from file to PLC
transferring data from PLC to file
replacing InitValue with current value
link animation

It is possible to use animation in safety mode (without link animation) and it is 
possible to stop and start the PLC.
33003885 07/2012 27



Project Management Unity Pro XLS Software
No Modifications in Safety Mode

A project cannot be modified in safety mode.

The following message is displayed if you try to modify a project in safety mode:

Modifications in animation tables are possible if generation of upload information is 
not enabled for animation tables (see General Settings for Safety Projects, 
page 64). Otherwise it is necessary to switch to maintenance mode if an animation 
table should be modified or created.
28 33003885 07/2012
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Maintenance Mode with Unity Pro XLS Software

Overview

Safety PLCs can run projects in two different modes:
safety mode
maintenance mode

The functions available in Unity Pro XLS Software depend on the current mode of 
the PLC to which Unity Pro XLS Software is connected.

Safety mode means that the Unity Pro XLS Software is connected to a safety PLC, 
which is running a project in safety mode. 

Maintenance mode means that Unity Pro XLS Software is connected to a safety 
PLC, which is running a project in maintenance mode.

For detailed information please refer to the Quantum Safety PLC Safety Manual, 
section Operating Procedures (see Modicon Quantum, Quantum Safety PLC, 
Safety Reference Manual).

Restrictions in Maintenance Mode

In Unity Pro XLS Software the maintenance mode is entered when the mode of a 
connected PLC is switched from safety mode to maintenance mode.

It is not possible to connect to a safety PLC, which already runs in maintenance 
mode. The reason for this is that a safety PLC will switch to safety mode if the 
connection to the Unity Pro XLS Software gets lost.

In maintenance mode the online functions of Unity Pro XLS Software are almost 
equal to Unity Pro XLS Software connected to a non-safety PLC (functions are 
limited by the user rights). This means that the restrictions of the safety mode 
(Restrictions in Safety Mode, page 27) do not exist.

But even in maintenance mode the following functions are not available:
transferring data from file to PLC
transferring data from PLC to file

It is possible to use animation in maintenance mode.
33003885 07/2012 29
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Switching Between Safety and Maintenance Mode

Overview

Switching a safety PLC from maintenance mode to safety mode is not possible if
the PLC is in debug mode,
a breakpoint is activated or
a watchpoint is set.

When the debug mode is not active, no breakpoint is activated and no watchpoint is 
set, it is possible to switch to the safety mode.

Before switching from maintenance to safety mode, Unity Pro XLS Software will ask 
for confirmation.

Switching Between the Modes

Two additional buttons in the toolbar are used to switch between safety mode and 
maintenance mode.

This new buttons are only available if you select a configuration with a safety PLC 
type.

New buttons

Switching can also be done via the main menu PLC → Safety/Maintenance or 
using the key combination CTRL+SHIFT+M.

Button Function

Clicking this button switches to safety mode.

Clicking this button switches to maintenance mode.
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Confirm Switching

Before switching between safety and maintenance mode, you are asked for 
confirmation:

Status Bar Information

The status bar displays information about the current mode.

See Status Bar of Unity Pro XLS Software, page 97.

Forced Variables

When switching to safety mode, forced variables will not be unforced.

WARNING
RISK OF PROCESSING FORCED DATA - UNEXPECTED EQUIPMENT OPER-
ATION

Make sure your data are correct when switching from maintenance Mode to safety 
Mode. The PLC proceeds using the forced data. Check your data in the animation 
tables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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In case of switching to safety mode you are asked for confirmation:

NOTE: This message is also shown, if Unity Pro XLS Software disconnects from a 
PLC and in the PLC there are forced variables. It does not care if the Unity Pro XLS 
Software is in safety mode or in maintenance mode.
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Monitoring Mode

Overview

If a PC running Unity Pro XLS Software programming software is connected to a 
PLC in either safety mode or maintenance mode then any other PC running 
Unity Pro XLS Software software can only connect to the same PLC in monitoring 
mode.

It is possible to connect to a safety PLC in monitoring mode even if the PLC is not 
connected to Unity Pro XLS.

In monitoring mode the animation functions of Unity Pro XLS Software can be used.

In monitoring mode, it is not possible to set either breakpoints or watch points.

Restrictions in Monitoring Mode

In monitoring mode the following functions of Unity Pro XLS Software Software are 
not available:

run/stop
download changes
debugging mode
setting a breakpoint
setting a watch point
transferring project to PLC
transferring project from PLC
transferring data from file to PLC
transferring data from PLC to file
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Connecting To A Safety PLC

Overview

Unity Pro XLS Software can be connected to a PLC with or without an opened 
project.

An option, configured by computer and not saved in the project, lets you choose 
between programming or monitoring mode.

Use the programming mode to modify a project. This mode is based on the 
reservation mechanism.
Use the monitoring mode to watch a project without changing the program.

NOTE: No upload is available in monitoring mode on a safety PLC.

Availability in Safety Mode

The following table shows the availability of the different controls in safety mode.

+ available
- Not available because the safety PLC is in safety mode.
-ncf In NoConf state key locked (equal safety mode), no action is possible with 

Unity Pro XLS Software except connection.

PLC State is Safety Mode

The basic PLC state is running in safety mode. Even if Unity Pro XLS Software was 
used to switch to maintenance mode, at disconnection PLC automatically switches 
to safety mode.

That is why at each connection, a not empty PLC is always in safety mode.

Unity Pro XLS
(Safety 
Project)

PLC User Action on Connection Run/
Stop

Switch to 
Maintenance

Upload Download

no project 
opened

configured
safe

enter PLC password + + - -

project opened
equal

configured
safe

nothing
(reservation automatically taken 
with same password as for open)

+ + - -

project opened
different

configured
safe

enter PLC password + + - -

project opened
different

NoConf nothing
(reservation automatically taken 
with same password as for open 
and PLC accepts any password 
in NoConf)

-ncf -ncf -ncf Download is 
possible only 
if the front 
panel key is 
unlocked.
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Replace Init Value

Update Init Values with Current Values is unavailable on safety CPU, in 
maintenance and in safety mode.

PLC Reserved

Connecting Unity Pro XLS Software to a safety PLC means that the PLC is reserved 
after the connection has been established.

No further Unity Pro XLS Software can connect to an already reserved PLC.
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Connecting to the PLC Simulator

Overview

The PLC simulator supports password protection for connection and the new modes 
(maintenance and safety) of safety PLCs.

Unity Pro XLS Software can build a safety project that can be downloaded to PLC 
simulator. With this you can check the programmed logic on the PLC simulator and 
verify the results of this programming. 

The PLC simulator will not behave like a real safety PLC in terms of safety behavior 
(e.g. no double code execution).
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Transferring a Safety Project to a Safety PLC

Preconditions

Unity Pro XLS Software is in connected programming mode with an opened project 
and the safety PLC is stopped. 

You have already entered a valid password.

There are two main cases:
PLC in safety mode
PLC in maintenance mode

PLC in Safety Mode

In safety mode the transfer is not possible. The button and menus are not available 
with an explanation in the status bar.

This is the default case just after the connection. In order to do any modification, you 
must switch to maintenance mode (see Switching Between Safety and Maintenance 
Mode, page 30).

PLC in Maintenance Mode

In any case (configured or not, equal or different) it is possible to transfer the safety 
project to the safety PLC.

Non-Safety PLC

You can use Unity Pro XLS Software to program non-safety projects and to connect 
to a non-safety PLC.

But it is not possible to transfer a non-safety project to a safety PLC.
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Transferring a Safety Project from a Safety PLC

Preconditions

Unity Pro XLS Software is connected to a PLC and no project is opened.

If a project was opened, it is first closed.

The password was checked at connection.

PLC in Maintenance Mode

In maintenance mode the Transfer Project from PLC button is available.

You can transfer the project from PLC by using this button.

To transfer the project from PLC in monitoring mode is not possible with 
Unity Pro XLS Software, as it is not possible to connect without reservation.
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Starting and Stopping a Safety Project

Starting PLC After Download

After transferring a safety project to the PLC, proceed as follows to start the PLC.

Performing Cold Start

For a cold start, proceed as follows.

Automatic Start

If you have configured the Quantum safety PLC to automatically start in run (in the 
CPU configuration dialog), it will start automatically after the initialization.

Stopping PLC in Safety Mode

If you want to stop a project, running in safety mode, proceed as follows.

Step Action

1 To start the PLC,
either select the menu command PLC → Run
or click the Run button in the toolbar.

Result: A dialog box is displayed where you have to confirm the starting of the 
PLC.

2 Confirm the starting of the PLC by clicking OK.
Result: The PLC is started and enters run state in safety mode.

Step Action

1 Power on your Quantum safety PLC.
Result: Unity Pro XLS Software performs self-tests and your project is 
initialized.

2 To start the project,
either select the menu command PLC → Run
or click the Run button in the toolbar.

Result: The PLC is started and enters run state in safety mode.

Step Action

1 Unlock the key switch.

2 To stop the PLC,
either select the menu command PLC → Stop
or click the Stop button in the toolbar.

Result: A dialog box is displayed where you have to confirm the stopping of the PLC.

3 Confirm the stopping of the PLC by clicking OK.
Result: The PLC is stopped.
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Stopping PLC in Maintenance Mode

To stop a project running in maintenance mode,

either select the menu command PLC → Stop
or click the Stop button in the toolbar.
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Project Properties and Password 
for Unity Pro XLS Software
Overview

This chapter describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to project properties and the password protection 
feature.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

Project Properties for Unity Pro XLS Software 42

Protection of a Safety Project with Unity Pro XLS Software 44

Application (Project) Password Request 47

Loss of Password 49
41
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Project Properties for Unity Pro XLS Software

At a Glance

Whichever view is displayed, you can access the project properties by using the 
Properties command from the context menu (which can be reached by right-clicking 
the mouse on the station folder). This gives you access to a dialog box which allows 
you to

access information on the current project,
define certain parameters of the project.

The following dialog box can be accessed from the structural view of the project:

Description of the Tabs

The dialog box has 4 tabs allowing the actions given below:

NOTE: By default, the dialog box is called Properties of Station. If you give the 
project another name, this dialog box is called Properties of "new name".

Tab Setting Description

General Name Allows you to define the name of the project (Station 
by default).

Type Indicates the type of Unity Pro software used.

Protection Protection active By checking this box, you activate the protection of 
the sections.

Change Password Allows you to change the password.

Clear Password Allows you to clear the password.

Identification Current version Allows you to identify the project.

Last rebuild all

Last partial build

Comment - Allows a comment to be associated with the project.
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Identification Tab for Unity Pro XLS Software

The following dialog box can be accessed by clicking the Identification tab.

Elements of the Identification tab:

Element Description

Last rebuild all product which generated this project file and
date when this project file was generated

Last partial all product which modified this project file last and
date when this project file was modified

Current version version number
For Unity Pro the check box Automatically 
incremented can be selected/cleared.
For Unity Pro XLS Software the check box 
Automatically incremented is selected and cannot be 
changed by the user. For safety PLCs the version 
number will always be in auto increment mode. Each 
build/rebuild will automatically increase the version 
number.
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Protection of a Safety Project with Unity Pro XLS Software

Overview

The project Protection feature is accessible via Project Browser → Station → 
Properties.

NOTE: Password protection for safety projects is always activated.

Default Password

A safety project is automatically password protected. By default an empty password 
is set and is a valid one.

It is possible to change password at any time. 

The password is either empty or must have a size between 4 and 16 alphanumeric 
characters.

Password Access Rights

To create or to modify the application password is restricted by access rights. (See 
Security Management for Unity Pro XLS Software, page 14.

Changing the Password

The following table shows the procedure for changing the application protection 
password.

Step Action

1 In the project browser select the Station directory.

2 Select the Properties command from the context menu.
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3 Select the Protection tab.
Result: The following dialog box is displayed:

4 In the Application field select the Change Password... button.
Result: The Modify Password dialog box is displayed:

5 Enter the previous password in the Old password field.

6 Enter the new password in the Entry field.

7 Enter the confirmation of the new password in the Confirmation field.

Step Action
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Clearing the Password

The following table shows the procedure for deleting the application protection 
password.

Auto-Lock Feature

There is an optional feature to limit access to the Unity Pro XLS Software 
programming tool after a configured time of inactivity.

After that time of inactivity a modal dialog box is displayed and asks you to enter the 
application password.

Behind the modal dialog box the current opened editors remain opened in the same 
position. That means that anybody can read the current content of the Unit Pro XLS 
windows but can not continue to work with Unity Pro XLS.

You can activate the auto-lock feature with the check box Auto-lock and select the 
time-out for the time of inactivity via Minutes before lock. After this time of inactivity 
the Unit Pro XLS lock mechanism is activated and you are asked to enter the 
application password.

The default values are
Auto-lock is activated
Minutes before lock are 10 minutes
The minimum value is 1. The maximum value is 999.

Step Action

1 In the project browser select the Station directory.

2 Select the Properties command from the context menu.

3 Select the Protection tab.

4 Select the Clear password... button.
Result: The Access control dialog box is displayed:

5 Enter the previous password in the Password field.

6 Click OK to confirm your choice and to delete the password.
46 33003885 07/2012



Project Properties and Password for Unity Pro XLS Software
Application (Project) Password Request

Overview

In different situations (open application, auto-lock, connect) you are asked to enter 
the case sensitive application (project) password.

There are 3 similar dialog boxes for this, depending on the situation.

Open Application (Project)

In case of Open Application (Project) the following dialog box is shown:

Auto-lock

In case of Auto-lock (when time is expired) the following dialog box is shown:

If... Then...

you choose OK Unity Pro XLS Software checks the entered password with the 
one in the source application.

the password is correct the selected action is done.

the password is wrong a message informs you and the dialog box is displayed again.

you choose Cancel the application (project) is not opened.

If... Then...

you choose OK Unity Pro XLS Software checks the entered password with the 
one in the source application.

the password is correct Unity Pro XLS Software becomes active again.

the password is wrong a message informs you and the dialog box is displayed again.

you choose Close the application (project) is closed without saving. In case you 
modified the application there will be a confirmation dialog.
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PLC Application Password

When trying to Connect to the PLC the following dialog box is shown:

If the project has been opened with Unity Pro XLS Software before and the project 
is equal to the one in the PLC, you do not have to enter the password again, because 
you already entered it when opening the project.

Therefore you must only enter the PLC Application Password if the project is 
different from the one in the PLC or if no project has been opened in Unity Pro XLS.

If... Then...

you choose OK the PLC compares the entered password with the one in the 
PLC. 

the password is correct the connection is done.

the password is wrong a message informs you that the action can not be done.

you choose Cancel the action you want to do (connecting for example) is not done.
48 33003885 07/2012



Project Properties and Password for Unity Pro XLS Software
Loss of Password

Overview

If you forget your password, contact the Schneider Support. 

There are two cases:
You forgot the password of the application (project) in Unity Pro XLS Software 
needed to open a project or at the auto-lock situation.
You forgot the password of the application that is in the PLC.

Local Application Password

At open time, the Open dialog box is displayed. You choose the application and 
then the Application Password dialog box is displayed.
Or
At auto-lock time, you are asked for the password. You must close the application 
because you do not remember your password. Then you reopen the application 
and the Application Password dialog box is displayed.

The following table shows the procedure for resetting the application protection 
password.

Step Action

1 Condition: The Application Password dialog box is displayed.

2 Press SHIFT+F2.
Result: A grayed number (5561 in the example) is displayed in the dialog box.

3 Give this number to Schneider Support.

4 Receive the generated password from Schneider Support.
Note: The password is a temporary password, available as long as you do not 
modify the application.

5 Enter this password.

6 Now it is very important that you modify the password (old password = the one 
provided by Schneider Support).

7 Click Build → Build Changes.

8 Save the application.
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PLC Application Password

The following table shows the procedure for resetting the PLC application password, 
if the respective *.STU file is available.

The following table shows the procedure for resetting the PLC application password, 
if the respective *.STU file is not available.

Step Action

1 Open the respective *.STU file.

2 When the password dialog box is displayed press SHIFT+F2.
Result: A grayed number is displayed in the dialog box.

3 Give this number to Schneider Support.

4 Receive the generated password from Schneider Support.
Note: The password provided by Schneider Support is a temporary password, 
available as long as you do not modify the application.

5 Enter this password.

6 Now it is very important that you modify the password (old password = the one 
provided by Schneider Support).

7 Connect to the PLC.

8 Click Build → Build Changes.

9 Save the application.

Step Action

1 Condition: At connection time, the PLC Application Password dialog box is 
displayed:

2 Press SHIFT+F2.
Result: A grayed number is displayed in the dialog box.

3 Give this number to Schneider Support.

4 Receive the generated password from Schneider Support.
Note: 
The received password is just used to unlock the situation. When you connect to 
the PLC, the old password is used to connect. 
Anyway, the password provided by Schneider Support is a temporary password, 
available as long as you do not modify the application.

5 Enter this password.

6 Upload the application from PLC.
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7 Save the application.

8 Modify the password (old password = the one provided by Schneider Support).

9 Click Build → Build Changes.

10 Save the application.

Step Action
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Network Configuration with 
Unity Pro XLS Software
Overview

This chapter describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to network configuration.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

Safety PLC Write Protection 54

Restrictions Configuring Quantum Networks with Unity Pro XLS Software 55
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Safety PLC Write Protection

Overview

IEC 61508 requires that non-safety devices cannot write into a safety PLC without 
control of the safety PLC.

In safety mode a write protection of the safety data is activated in the safety PLC.

The write protection is independent of the protocol (e.g. Modbus Plus or Ethernet) 
and also independent of other devices (e.g. HMI or other PLC). 

Write protection is not activated in maintenance mode.

There is no restriction for other devices to read data from a safety PLC.

Write Data to Safety PLC

In some cases it is required to write data to the safety PLC, e.g. to change set points.

For safety projects, to allow writing from an HMI or other PLCs, there are dedicated 
Unrestricted Memory Areas for bits (%M) and for words (%MW).

These memory ranges are not write protected and are located at the beginning of 
the complete memory range.

You can define a contiguous area of %M and %MW for which the safety PLC allows 
write access.

Unlocated variables cannot be used in safety projects.

Unrestricted Memory Areas

The Unrestricted Memory Areas can be defined in the Configuration tab of the 
rack configuration dialog.

There you can define the size of these non-protected areas (starting from the 
beginning, with an end index) in %M and %MW.

The values entered must be inside the configured area of %M and %MW (state non-
protected areas must be adapted.

For further information please refer to Configuration of Quantum Processors with 
Unity Pro XLS Software, page 75.

New Function Blocks

The values from the unrestricted memory areas cannot be used directly in the safety 
logic.

Instead, the new function blocks S_SMOVE_BIT and S_SMOVE_WORD have to be 
used.

For further information please refer to Unity Pro Safety Block Library.
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Restrictions Configuring Quantum Networks with Unity Pro XLS Software

Overview

In the Quantum network configuration the communication with other PLCs, but also 
with field I/O (Ethernet I/O, Modbus Plus I/O, e.g. Momentum), is configured.

Communication with other PLCs is allowed (in a restricted way), while the usage of 
Ethernet I/O and Modbus Plus I/O is prohibited.

Since the communication to other PLCs is configured in the same ways as the field 
I/O - the communication is configured by specifying the address of the other device 
- Unity Pro XLS Software cannot check this rule.

Ethernet and Modbus Plus I/O are not allowed in safety PLCs and you are 
responsible to obey this rule.

Modbus Plus Network (Peer Cop Service)

The communication on a Modbus Plus network can be either specific (peer-to-peer) 
or global (broadcast). Reading (input) and writing (output) are configured 
independently.

Since there is no restriction for a safety PLC to write data to another PLC the 
configuration for specific output and global output is the same as with the standard 
version of Unity Pro.

For reading from another PLC (either global or specific) a destination address range 
has to be specified where the received data will be stored.

The reading from another PLC is only allowed into the unrestricted memory area 
(similar to HMI writing, see Safety PLC Write Protection, page 54).

During analyze time Unity Pro XLS Software checks that only addresses from the 
unrestricted memory area are used for the destination reference. Otherwise an error 
is created to indicate that receiving ModbusPlus data is only allowed in the 
unrestricted memory area.

If an error is detected Build is not possible.

Ethernet Network (I/O Scanning Service)

The communication on an Ethernet network can be peer-to-peer (I/O scanning).

Since there is no restriction for a safety PLC to write data to another PLC the 
configuration for writing is the same as with the standard version of Unity Pro.

For reading from another PLC a destination address range has to be specified 
where the received data will be stored.
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The peer-to-peer communication can be done with a SIL3 level by configuring a 
specific configuration (see Modicon Quantum, Quantum Safety PLC, Safety 
Reference Manual). The reading from another PLC is only allowed into the 
unrestricted memory area (similar to HMI writing, see Safety PLC Write Protection, 
page 54).

During analyze time Unity Pro XLS Software checks that only addresses from the 
unrestricted memory area are used for the destination reference. Otherwise an error 
is created to indicate that receiving Ethernet data is only allowed in the unrestricted 
memory area.

So, the %M and %MW should be in the unrestricted memory area. And the %I and 
%IW values are forbidden.

If an error is detected Build is not possible.

Ethernet Network (Global Data Service)

The communication on an Ethernet network can also be global (global data, 
broadcast). Reading (subscribe) and writing (publish) are configured independently.

Since there is no restriction for a safety PLC to write data to another PLC, variables 
can be published in the same way as with the standard version of Unity Pro.

For reading from another PLC the variable has to be set to subscribe in the data 
editor. 

Subscribing a variable from another PLC is only allowed if its address is in the 
unrestricted memory area (similar to HMI writing, see Safety PLC Write Protection, 
page 54).

During analyze time Unity Pro XLS Software checks that only addresses from the 
unrestricted memory area are used for the subscribed variables. Otherwise an error 
is created to indicate that receiving Ethernet data is only allowed in the unrestricted 
memory area.

If an error is detected Build is not possible.

Ethernet Network (Messaging Service)

Messaging communication is used with special communication function blocks, 
which are not certified and therefore cannot be used in safety logic.

Therefore it’s not possible to read data via messaging in the safety PLC.
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Programming with Unity Pro XLS 
Software
Overview

This chapter describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to programming editors.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

Program Structure Restrictions for Safety Projects 58

Import Restrictions for Safety Projects 59

Sections and Data Type Restrictions for Safety Projects 61

General Settings for Safety Projects 64

Variable Settings for Safety Projects 66

Language Settings for Safety Projects 68
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Program Structure Restrictions for Safety Projects

Overview

For a safety project, at analyze time, Unity Pro XLS Software checks that restrictions 
applied to the program structure are fulfilled. Otherwise a build is not possible.

If a build is not possible an error message is displayed.

Program Structure Restrictions

There are the following restrictions for Quantum safety program structure:
no other tasks than the MAST task
no sub-routines (SR)
no I/O event
no timer event

With Unity Pro XLS Software working with Quantum safety PLCs it is not possible to 
create other objects than sections in the MAST task.

Import of a Project

With Unity Pro XLS Software you can import data that may not be correct (e.g. 
hardware modules which are not allowed in safety projects).

If during import or partial import objects that are not allowed are detected, they are 
ignored (not imported) and error messages are displayed.

Language Restrictions

There are the following language restrictions for Quantum safety:
no other sections than FBD and LD sections

At creation time only FBD and LD section are available for sections.

At import time, only LD and FBD sections are imported. Other sections generate 
error messages, but do not stop the import.

No RIO Parallelism

There are the following RIO restrictions for Quantum safety:
no remote I/O associated with a section

If Unity Pro XLS Software detects a remote I/O associated with a section at analyze 
time, a build is not possible.

If such a RIO assignment is detected an error message is displayed.

In safety projects, the RIO are read at cycle start and written at the end of the cycle. 
No parallel call will be done using section RIO association.

If a task is imported, with such a RIO assignment, it will be skipped.
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Import Restrictions for Safety Projects

Overview

With Unity Pro XLS Software you can import data that may not be correct (e.g. using 
hardware modules which are not allowed in safety projects).

If during import or partial import objects that are not allowed are detected, they will 
be ignored (not imported) and error messages are displayed.

Objects that are not allowed are described in Program Structure Restrictions for 
Unity Pro XLS Software (see page 58) and Sections and Data Type Restrictions for 
Unity Pro XLS Software (see page 61)

Only FBD and LD Sections

At import time, only LD and FBD sections are imported. Other sections will generate 
error messages, but will not stop the import.

RIO Import

If Unity Pro XLS Software detects a remote I/O associated with a section at import 
time an error messages is displayed and a build is not possible.

If a task is imported, with such a RIO assignment, it will be skipped.

Partial Import

It is not possible to partially import a safety PLC program into a non-safety project 
and vice versa (see page 72).

FFB Import

The import of FFBs which are not available in safety projects results in type errors 
in the language editor.

For further information on safety FFBs please refer to Unity Pro Safety Block Library.

DFB Import

It is possible to import a DFB type from the safety library into a safety application.

Diagnostic DFB Import

It is not possible to import a diagnostic DFB type into a safety application. Trying to 
import a diagnostic DFB type into a safety application will be unsuccessful.

An error will be displayed (Diagnostic DFB types are not allowed into safety project. 
Import failed).
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Unlocated Variables Import

As unlocated variables can be created through source file import an error message 
will also be displayed at analyze time.

Sub-Routines (SR) Import

As sub-routines (SR) can be created through source file import an error message 
will also be displayed at analyze time.

Variables from Unrestricted Memory Area Import

As Variables from the unrestricted memory area can be created through source file 
import an error message will also be displayed at analyze time.

ST Expressions Import

As ST expressions can be created through source file import an error message will 
also be displayed at analyze time.

Data Types

As variables of a forbidden type (e.g. STRING) can be created through source file 
import an error message will also be displayed at analyze time.

DDT Import

As DDTs can be created through source file import an error message will also be 
displayed at analyze time.
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Sections and Data Type Restrictions for Safety Projects

Overview

For a safety project, at analyze time Unity Pro XLS Software checks that restrictions 
applied to sections and data types are fulfilled. Otherwise a build is not possible.

If a build is not possible an error message is displayed.

Safety FFBs Only

Only safety FFBs (see Unity Pro, Safety, Block Library) are allowed to be used in a 
safety project.

If a section contains one or more non-safety FFBs, an error is displayed (type not 
allowed).

The import of FFBs which are not available in safety projects results in type errors 
in the language editor.

DFBs

DFBs are allowed to be used in a safety project. 

The creation of DFB is allowed in the Data Editor.

The user safety DFBs can be stored in the custom library and reused in a safety 
project.

It is possible to import a DFB type into a safety application.

No Diagnostic DFBs

Diagnostic DFBs are not allowed in a safety project. 

Unity Pro XLS Software handles Diagnostic DFBs like common DFBs. If a section 
contains one or more Diagnostic DFBs an error message is displayed (type not 
allowed).

Located Variables Only

Only located variables are allowed to be used in a safety project.

Instances of variables are checked to verify they are located in a valid memory area. 
If an unlocated variable exists at analyze-time, an error message is displayed 
(unlocated variables are not allowed in a safety project).

As unlocated variables can be created through source file import this error message 
will also be displayed at analyze time.
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No Sub-Routines (SR)

No sub-routines (SR) are allowed to be used in a safety project.

At analyze time Unity Pro XLS Software checks that there are no call-coils in LD 
sections and no sub-routine calls in FBD sections. Otherwise an error message is 
displayed (sub-routine calls are not allowed in a safety -project).

Variables from Unrestricted Memory Area

Variables from the unrestricted memory area are not allowed to be used in the logic 
except on the IN pin of the S_SMOVE_* EFBs.

LD Section Restrictions

In LD sections you are not allowed to use
halt coils,
call coils,
returns,
operate blocks,
compare blocks.

No ST Expressions

No ST expressions are allowed (no compare and no operate blocks).

No Halt Coils/EFs

No halt coils and no halt EFs are allowed in a safety application

Data Types

Only elementary data types BOOL, EBOOL, BYTE, WORD, DWORD, INT, UINT, DINT, 
UDINT, TIME, REAL and one dimensional arrays of these types are allowed to be 
used in a safety project.

Variables must be one of these types. At analyze time, if a variable of a forbidden 
type (e.g. STRING) is detected, an error message is displayed (Type not allowed. 
Only whole numbers or boolean types can be used in safety projects).

No DDTs

No DDTs are allowed (exception: simple arrays are allowed).

Variables must be one of the data types mentioned above. DDTs cannot be created, 
if a variable of a DDT type is detected, an error message is displayed. (Type not 
allowed. Only whole numbers or boolean types can be used in a safety project).

It is not possible to import a DDT type into a safety application. Trying to import a 
DDT type into a safety application will be unsuccessful. An error will be displayed 
(DDT types are not allowed into safety project. Import failed).
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Simple Arrays

Simple arrays are allowed for global data only.

The use of simple arrays is allowed inside safety applications for integration of global 
data. Simple arrays can only have a static index-parameter.

The meaning of simple arrays is:
only vectors (1 dimension) allowed
the type of the elements must be 1 of the elementary types listed above
an array must be contained completely either in the unrestricted memory area or 
in the safety memory area (an array is not allowed to overlap different memory 
areas)
the index of a simple array can only be a literal
no nested arrays are allowed
simple arrays can be used for global data only

Direct Addresses

It is allowed to use direct addresses in a safety project.

E.g. %MW4000 can be written by a coil in ladder diagram.
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General Settings for Safety Projects

Overview

The restrictions described in this section apply only to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the General Dialog section

The Build settings dialog box used to modify the project generation settings can be 
accessed via Tools → Project Settings → General.

General Project Settings

The dialog box below shows the build project settings:
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Availability for Safety Projects

The following settings are not available for safety projects:

Setting Availability Comment

Build Settings

Create New data 
block on line

Not available
Default value = FALSE

Not applicable for safety projects

Free data memory 
(in kbytes)

Not available
Default value = 1K

The default value (1k) is sufficient 
because it is only used for link animation 
hidden variable (1 per section).

Virtual connected 
mode

Not available
Default value = FALSE

Not applicable for safety projects

Optimized Code Not available
Default value = FALSE

This optimized code removes some run-
time checks on array. This is not 
applicable for safety projects.

PLC embedded data

Data dictionary Not available
Default value = FALSE

Optimize data on-
line change

Not available
Default value = FALSE

PLC diagnostics

Application 
diagnostics

Not available
Default value = FALSE

No diagnostic FFBs allowed for safety 
projects

Rack Viewer 
diagnostics 
information

Not available
Default value = FALSE

Not applicable for safety projects

Program Viewer 
information

Not available
Default value = FALSE

Not applicable for safety projects

PLC behaviour

Reset %M on Stop-
>Run transition

Not available
Default value = FALSE

Not applicable for safety projects
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Variable Settings for Safety Projects

Overview

The restrictions described in this section apply only to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the General Dialog Section

The Variables dialog box used to modify the project generation settings can be 
accessed via Tools → Project Settings → Variables.

Variable Settings

The dialog box below shows the Variables project settings:
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Availability for Safety Projects

The following settings are not available for safety projects:

Setting Availability Comment

Directly represented 
array variables

Not available
Default value = 1K

Not allowed for safety projects

Allow dynamic 
arrays 
[ANY_ARRAY_XXX]

Not available
Default value = FALSE

Not allowed for safety projects

Disable array size 
compatibility check

Not available
Default value = FALSE

Not allowed for safety projects
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Language Settings for Safety Projects

Overview

The restrictions described in this section apply only to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the Language Extensions Dialog Box

The Languages dialog section can be accessed via Tools → Project Settings → 
Program → Languages.

Languages Settings

The dialog box below shows the Languages settings:
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Availability for Safety Projects

The following Languages settings are not available for safety projects:

Setting Availability Comment 

Common

Allow subroutines Not available
Default value = FALSE

Subroutines are not allowed in 
safety projects

Allow nested 
comments

Not available
Default value = FALSE

Nested comments are not 
allowed in safety projects

Allow multi 
assignment [a:=b:=c] 
(ST/LD)

Not available
Default value = FALSE

Multi assignment [a:=b:=c] 
(ST/LD) is not allowed in safety 
projects

Allow empty 
parameters in non-
formal call (ST/IL)

Not available
Default value = FALSE

Empty parameters in non-
formal call (ST/IL) are not 
allowed in safety projects

Usage of ST 
expressions (LD/FBD)

Not available
Default value = FALSE

ST expressions (LD/FBD) are 
not allowed in safety projects

SFC

SFC (Sequential 
Function Chart)

Not available SFCs are not allowed in safety 
projects

ST

ST (Structured Text) Not available
Default value = FALSE

ST expressions are not allowed 
in safety projects
Note: This implies that compare 
blocks and operate blocks are 
not allowed. So numerical 
operations are possible only via 
graphical FFB.

LL984

LL984 Not available
Default value = TRUE

LL984 is not allowed in safety 
projects
33003885 07/2012 69



Programming with Unity Pro XLS Software

70 33003885 07/2012



33003885 07/2012
6

Unity Pro XLS Software

Project Configuration with Unity Pro XLS Software

33003885 07/2012
Project Configuration with 
Unity Pro XLS Software
Overview

This chapter describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to PLC configuration.

What Is in This Chapter?

This chapter contains the following topics:

Topic Page

Restrictions Configuring Quantum Safety PLCs with Unity Pro XLS 72

Configuration of Quantum Processors with Unity Pro XLS Software 75

Using Data from the Unrestricted Memory Area 79

Configuring I/O Modules for Safety Projects 80
71
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Restrictions Configuring Quantum Safety PLCs with Unity Pro XLS

Overview

For a safety project, at analyze time Unity Pro XLS checks that restrictions applied 
to safety hardware configurations are fulfilled. Otherwise a build is not possible.

If a build is not possible an error message is displayed.

Restrictions for Safety Hardware Configuration

There are the following restrictions for Quantum safety hardware configurations:
only safety modules and non-interfering modules are allowed
DIO field busses are not allowed (RIO field busses are allowed)
extension racks are not allowed
other field busses are not allowed
I/O module sniffing is allowed

Module Definition

For detailed information please refer to the Quantum Safety PLC Safety Manual, 
section Safety Certification (see Modicon Quantum, Quantum Safety PLC, Safety 
Reference Manual).

From the Unity Pro  XLS point of view there is no difference between safety and non-
interfering modules. System designers, programmers and users must ensure that 
non-interfering modules are not used as part of the safety loop. The values from 
non-interfering input modules must not be used to calculate safety output and only 
safety output modules have to be used for safety outputs. 

It is allowed to use non-interfering modules. You are responsible to use these non-
interfering modules only for non-safety parts of the controlled process. 

Unity Pro XLS offers modularization by means of sections. Therefore it is 
recommended to use the non-safety-related logic and I/O in dedicated sections.

Non-interfering modules can then be placed in the local rack and mixed with safety 
modules, and/or placed in Remote I/O drops (except the NOE).

Module Description

Safety Module modules used to control the safety functions

Non-interfering Module modules used to control the non-safety functions, but do 
not interfere with the safety modules

Non-Safety Module other modules that can not be mixed with safety modules
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Safety- and Non-Interfering Modules

DIO Field Busses

DIO field busses are not allowed.

The DIO check box in the module editor on the Modbus Plus port inside the PLC will 
be unchecked and disabled if the configured PLC is a safety PLC.

RIO Field Busses

RIO field busses are allowed.

Extension Racks

Extension racks are not allowed.

No extension racks are allowed, neither for local rack nor for remote drops. 

No empty rack connection point for extension racks exists in the bus editor if the 
configured PLC is a safety PLC. The local rack is shown as any non-extensible rack. 
It is not possible to add an extension rack in the bus editor.

Other Field Busses

Other field busses are not allowed.

Bus master modules of other field busses neither have the safety- nor the non-
interfering attribute. Therefore it is not possible to add them in a bus editor.

I/O Module Sniffing

I/O module sniffing is allowed even with a safety project.

If the PLC configured in the project is a safety PLC and the existing PLC is a non-
safety PLC then sniffing is not allowed. And vice versa.

Sniffing may introduce non-safety modules in the project but this will be detected at 
analyze time.

If... Then...

the configured PLC is a safety PLC the configuration editor will prevent adding 
any module without the safety- or non-
interfering attribute.

the configured PLC is a non-safety PLC the configuration editor will prevent adding 
any module with the safety attribute.
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PLC Replacement

The following rules apply to PLC replacements:
A safety PLC can only be replaced by a safety PLC.
A non-safety PLC can only be replaced by a non-safety PLC.
The version of the PLC cannot be downgraded (a Safety PLC V1.00 replacing a 
Safety PLC V2.00) unless there are not any of the new floating point FFBs/REAL 
variables (Unity Pro 4.1) in the application.

Unity Pro XLS checks the new PLC before replacing the old one.

If replacement is not possible, an error message is displayed.

Partial Import

The same restrictions as to PLC replacement apply to partial import.

It is not possible to partially import a safety PLC into a non-safety project and vice 
versa.
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Configuration of Quantum Processors with Unity Pro XLS Software

Overview

The restrictions described in this section only apply to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the Configuration Dialog Box

The Quantum PLC Configuration dialog box can be accessed via:

Edit → Open module when the PLC is selected in the Bus Editor

Accessing the Configuration Dialog Box

To access the Quantum PLC Configuration dialog box proceed as described 
below.

Step Action

1 Access the rack configuration screen.

2 Select the processor.

3 Using the context menu, click Open Module.

4 Select the Configuration tab.
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Processor Configuration

The following figure shows a Quantum processor configuration dialog box:

Unrestricted Memory Areas

This feature is only available for Unity Pro XLS Software working with Quantum 
safety PLCs.

For safety projects, to allow writing from an HMI or other PLCs there are dedicated 
unrestricted memory areas for bits (%M) and for words (%MW). 

These memory ranges are not write protected and are situated at the beginning of 
the complete memory range.

You can define a contiguous area of %M and %MW for which the safety PLC allows 
write access.

More information is available about unrestricted memory areas (see page 53).
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State RAM Viewer

In the processor configuration dialog box click on Viewer to open the state RAM 
viewer.

Elements of the state RAM viewer

Element Description

Table This table represents the mapping of the memory area selected in the 
Memory Area field.
The occupied memory addresses are marked by dashes:

blue: for module type objects
red: for objects entered in the program
green: for objects defined in the variable editor
yellow: for unrestricted memory areas (UMA),
only available in Unity Pro XLS Software

The scroll bars can be used to access the entire memory area.

Modules, 
Variables 
Language and 
Unrestricted 
Memory Areas 
check boxes

These check boxes are used to filter the information displayed in the table. 
If, for example, Modules is the only thing checked, only module-type 
information will be displayed.
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Address 
Information

By entering the object and its address in the Address fields and clicking 
on the Go To button, you display directly the address in the table (without 
using the scroll bars). This zone also has a display function; it displays the 
object and address of the box selected in the table. For module-type 
objects, it also gives the topological address of the module concerned.

Memory Area 
option buttons

These option buttons are used to select the memory area to display in the 
table:

%M (0x) output module bits and internal bits 
%I (1x) internal module bits
%IW (3x) input/output register words and internal words
%MW (4x) I/O module output words and internal words

Element Description
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Using Data from the Unrestricted Memory Area

Data from Unrestricted Memory Area

To use data from the unrestricted memory area, that is to transfer them to the safety 
memory area, proceed as follows:

S_SMOVE_*** Function Blocks

For further details on the S_SMOVE_*** function blocks please refer to the Unity Pro 
Safety FFB Library.

Step Action

1 Declare variables of type EBOOL or WORD.

2 Map the declared variables to the unrestricted memory areas as follows:
EBOOL variables to %M
WORD variables to %MW

3 For transfer to the safety memory area, use
the S_SMOVE_BIT function block to move BOOL variables,
the S_SMOVE_WORD function block to move WORD variables.

4 Use the data in the safety memory area.
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Configuring I/O Modules for Safety Projects

Maximum Consecutive CRC Error

To configure the maximum consecutive CRC error of safety I/O modules, proceed 
as follows:

Timeout State of Output Modules

To configure the timeout state of a safety digital output module, you first must open 
the module as described above, then proceed as follows:

Step Action

1 In the Project Browser double-click the Configuration folder to open it.

2 Double-click the Local Bus or the RIO Bus.
Result: The Local Bus or RIO Bus window is displayed.

3 Click the input or output module concerned.

4 Open the module by selecting the menu command Edit → Open Module.
Result: The Config tab of the module window is displayed.

5 In the Parameter Name column, double-click the MAX CONSECUTIVE CRC 
ERROR row.

6 In the Value column, type the number of errors that you want your module to 
maximally accept before entering safe state.
Note: You can configure a value of 0, 1, 2, or 3 for each I/O module. Setting it to 
0 means that the module enters safe state as soon as the CRC error is detected. 
Setting it to n means that n consecutive CRC errors are accepted before the 
module enters safe state.

7 Close the module window.
Result: A validation dialog box is displayed.

8 Validate your selection by clicking Yes.

9 Save your project.

Step Action

1 In the Parameter Name column, double-click the MODULE TIME OUT row.

2 In the Value column, type the number of ms that you want to pass by before your 
module enters fallback state.

3 In the Parameter Name column, open the TIMEOUT STATE folder by clicking 
the plus sign button.
Result: Each channel is displayed in a row.

4 Open the CHANNEL 1 row by clicking the plus sign button.
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5 In the Value box in the Value column, select the value that you have chosen.
Note: If you select USER DEFINED, a default value of 0 is set.
To change it:

Open the CHANNEL 1 row by clicking the plus sign button.

In the Value column, double-click the Value row.
Type 1, as this is the only alternative value.

6 Repeat steps 4 and 5 to configure the timeout states of the other channels.

7 Close the module window.
Result: A validation dialog box is displayed.

8 Validate your selection by clicking Yes.

9 Save your project.

Step Action
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Debugging the Program with 
Unity Pro XLS Software
Overview

This chapter describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to debugging features.

What Is in This Chapter?

This chapter contains the following sections:

Section Topic Page

7.1 PLC Debug Screen for Unity Pro XLS Software 84

7.2 PLC Simulator for Unity Pro XLS Software 90
83
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7.1 PLC Debug Screen for Unity Pro XLS Software

Overview

This section describes the specifics of Unity Pro XLS Software, working with 
Quantum safety PLCs, referring to debug screen (associated with the PLC).

For standard (non-safety) features concerning debug screen please refer to the 
standard Unity Pro XL Software documentation.

What Is in This Section?

This section contains the following topics:

Topic Page

Task Tab: Task Field 85

Task Tab: Operating Mode 87

Info Tab 88
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Task Tab: Task Field

Overview

The restrictions described in this section only apply to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the PLC Screen

The task tab of the PLC Screen dialog box can be accessed via Tools → PLC 
Screen → Task.

Task Checking Field

This field gives you access to the display and settings of the task periods and the 
various task execution commands.

This field may be extended according to the tasks configured in the project: one line 
per auxiliary task may be displayed in addition to those in the above screen. 

Minimum Duration

This value defines the minimum duration of task execution, measured from the last 
cold restart or re-initialization using the Init Duration command.

NOTE: The minimum duration of a safety project is 20 ms.

Availability

The following table shows the values and the availability of different controls 
depending on the PLC (safety/non-safety) and the safety mode.

Control Non-Safety PLC Safety PLC in 
Maintenance Mode

Safety PLC in 
Safety Mode

Operating Mode RUN/STOP enhanced with
RUN MAINTENANCE
STOP MAINTENANCE

enhanced with
RUN SAFE
STOP SAFE

Cmd RUN/STOP RUN/STOP It is not possible to 
run/stop the task in 
safety mode.
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For further information on safety mode please refer to Safety Mode with Unity Pro 
XLS Software, page 27.

Activation Task ENABLE/DISABLE It is not possible to 
disable the task for safety 
projects.

It is not possible to 
disable the task for 
safety projects.

Events available not available not available

Control Non-Safety PLC Safety PLC in 
Maintenance Mode

Safety PLC in 
Safety Mode
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Task Tab: Operating Mode

Overview

The restrictions described in this section only apply to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the PLC Screen

The task tab of the PLC Screen dialog box can be accessed via Tools → PLC 
Screen → Task.

Operating Mode Field

This field gives you access to a simulation button:

This field also indicates the date, time and cause of the last PLC stop.

Description

Button and function

Button Function

Cold start Click on this button to perform a cold start of the PLC.
This initializes the data, the system, and sets the %S0 bit to 1 which (in this 
case) is used for example to command a specific initialization program.
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Info Tab

Overview

The restrictions described in this section only apply to Unity Pro XLS Software 
projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Accessing the Information Tab

The Information tab can be accessed via Tools → PLC Screen → Information.

Information Tab

The Information tab is composed of 2 areas: 

the browser, which is used to choose the subject 
the display area in which information concerning the chosen subject is displayed. 

PROCESSOR NAME

If a safety PLC is connected, this is indicated by a capital S at the end of the 
processor name (e.g. 140 CPU 651 60S).
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SAFETY/MAINTENANCE MODE

This information is only shown for Quantum safety PLCs. The current mode of the 
connected PLC is displayed (maintenance or safety).

For Unity Pro XLS Software this information is also shown in the status bar.
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7.2 PLC Simulator for Unity Pro XLS Software

Simulator Control for Quantum Safety PLC

Introduction

The dialog box is shown if the simulator is simulating a PLC from the Quantum safety 
family.

Representation of the dialog box

PLC Front Plate

The virtual PLC front plate shows the current state of the safety PLC in a display.

Text in the 
Display

The Simulated 
PLC is in State...

Meaning

Init INIT (Initialization) This display is shown for a very short time while the 
simulator is starting. It is quickly replaced by one of 
the following displays.

UnCfg NOCONF (no 
configuration)

No user project loaded or the loaded project is 
invalid.

Idle IDLE The project loaded on the PLC has not been started 
or reset with the Reset command button.
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Safety/Maintenance Mode (Safety Projects)

For switching between safety and maintenance mode please pay attention to the 
following special features:

Switching from safety to maintenance mode in Unity Pro XLS Software is only 
possible, if the simulator´s key switch is unlocked (see table below).
Switching from maintenance to safety mode can be done by setting the key 
switch position of the simulator to locked.
If the simulator is in maintenance mode and Unity Pro XLS Software is 
disconnected from the simulator, it is automatically set to safety mode.

NOTE: The PLC simulator has no double code execution of the logic and 
comparison of the results. Therefore the execution behaves the same in safety and 
maintenance mode. 

For further information on the different modes please refer to the Unity Pro XLS 
Software Specifics manual.

Stop STOPPED No project is running. However, the loaded project 
was in RUN state at least once.

Run RUN A project with at least one task is running.

Halt HALT An error has occurred in the project. The simulated 
PLC must be re-initialized or reset using the Reset 
command button.

Err ERROR An fatal error has occurred in the project. This 
means communication is no longer possible. The 
simulated PLC must be reset using the Reset 
command button.

S Safety Mode The project is running in safety mode.
For further information on the different modes 
please refer to the Unity Pro XLS Software 
Specifics manual.

M Maintenance 
Mode

The project is running in maintenance mode.
For further information on the different modes 
please refer to the Unity Pro XLS Software 
Specifics manual.

Text in the 
Display

The Simulated 
PLC is in State...

Meaning
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Key Switch

By clicking with the mouse on the switch symbol, various switch positions can be 
simulated.

Meaning of the switch positions

Reset

With this command button, you can reset the simulated PLC (and the simulator). 
This corresponds to a cold start of the PLC (the connection between the Unity Pro 
and simulator is broken, project variables are reset).

This command button corresponds to the reset button on a real CPU.

Power Cycle

With the command button, you simulate a cold start of the PLC (since a safety PLC 
does not support warm start), i.e. the connection between Unity Pro and the 
simulator is broken, the simulator goes into the state RUN (autostart active) or STOP 
(autostart deactivated).

This command button corresponds to the unplugging and plugging in of a power 
supply.

Host PC name

This text field shows the DNS name of the host PC for the simulator.

If the PC has multiple network cards, only the first is shown.

Host IP address

This text field shows the TCP/IP address of the host PC for the simulator.

If the PC has multiple network cards, only the first is shown.

Switch 
Position

Switch Position 
on Real CPU

Meaning

Start PLC unlocked
project can be loaded
PLC can be started or stopped

Mem Prt PLC locked
project can not be loaded
As opposed to the key switch on a real CPU, the 
PLC can be started or stopped in this position.

- Stop This switch position of a real CPU is not supported by 
the simulator.
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Project name

This text field shows the name of the loaded project.

Clients connected

The list box shows current clients connected with the PC (PCs which are connected 
via TCP/IP with the Host PC of the simulator). The DNS name and TCP/IP address 
of its host PC are shown for each client.
33003885 07/2012 93



Debugging with Unity Pro XLS Software

94 33003885 07/2012



Unity Pro XLS Software

33003885 07/2012
Appendices
Overview

This part describes the specifics of Unity Pro XLS Software ergonomics compared 
to Unity Pro XL Software and the system objects (system bits and words).

What Is in This Appendix?

The appendix contains the following chapters:

Chapter Chapter Name Page

A User Interface of Unity Pro XLS Software 97

B System Objects 99
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User Interface of Unity Pro XLS Software

33003885 07/2012
User Interface of Unity Pro XLS 
Software
Status Bar of Unity Pro XLS Software

Overview

The additional features described in this section only apply to Unity Pro XLS 
Software projects working with Quantum safety PLCs.

For standard (non-safety) features please refer to the standard Unity Pro XL 
Software documentation.

Displayed Information

The status bar displays information about the current project on the PC, about the 
PLC and about the software status.

Example: Online status bar

1 Current Mode

Maintenance/ Safety Mode

In addition to information displayed in the status bar of standard Unity Pro XL 
Software, for Unity Pro XLS Software projects working with Quantum safety PLCs 
the current mode (maintenance/safety) of the connected PLC is displayed.

This information is available in connected mode even if no project or a different 
project is opened.
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System Objects
Introduction

This chapter describes the system bits and words of the Quantum Safety PLC.

Note: The symbols associated with each bit object or system word mentioned in the 
descriptive tables of these objects are not implemented as standard in the software, 
but can be entered using the data editor.

It is suggested that the symbol names associated with the system bits and system 
words that appear on the following pages be implemented to provide continuity and 
ease of understanding. Example: %S0 COLDSTART (the user can select another 
word to replace COLDSTART).

What Is in This Chapter?

This chapter contains the following sections:

Section Topic Page

B.1 System Bits 100

B.2 System Words 109
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B.1 System Bits

Introduction

This section describes the system bits of the Quantum Safety PLC. 

For your convenience, all system bits of standard Quantum PLCs are listed but only 
explained further if used in the Quantum Safety PLC.

What Is in This Section?

This section contains the following topics:

Topic Page

System Bit Introduction 101

Description of the System Bits %S0 to %S13 102

Description of the System Bits %S15 to %S21 104

Description of the System Bits %S30 to %S51 106

Description of the System Bits %S59 to %S122 107
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System Bit Introduction

General

The Quantum PLCs use %Si system bits which indicate the state of the PLC, or they 
can be used to control how it operates.

These bits can be tested in the user program to detect any functional development.

Some of these bits must be reset to their initial or normal state by either the program 
or the user. Other bits are automatically reset by the system. Finally, there are bits 
which only display the status of the PLC.
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Description of the System Bits %S0 to %S13

Detailed Description

NOTE: Not all of the system bits can be used in the Quantum Safety PLC. The 
unusable system bits are marked in the Quant. Safety column with no.

The following table gives a description of the system bits %S0 to %S13:

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%S0
COLDSTART

cold start Normally at 0, this bit is set to 1 by:
power restoration with loss of data (battery related),
the user program,
the terminal,
a change of cartridge,

This bit is set to 1 during the first complete restored 
cycle of the PLC either in RUN or in STOP mode. It is 
reset to 0 by the system before the following cycle.
%S0 is not always set in the first scan of the PLC. If a 
signal set for every start of the PLC is needed, %S21 
should be used instead. 

1
(1 cycle)

no yes

%S1
WARMSTART

warm 
restart

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

0 no no

%S4
TB10MS

time base
10 ms

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

- no no

%S5
TB100MS

time base
100 ms

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

- no no

%S6
TB1SEC

time base
1 s

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

- no no

%S7
TB1MIN

time base
1 min

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

- no no
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%S10
IOERR

input/output 
fault

Normally at 1, this is set to 0 when an I/O fault on an in-
rack module or device on Fipio is detected (e.g. non-
compliant configuration, exchange fault, hardware 
fault, etc.). The %S10 bit is reset to 1 by the system as 
soon as the fault disappears.

1 no yes

%S11
WDG

watchdog 
overflow

Normally at 0, this is set to 1 by the system as soon as 
the task execution time becomes greater than the 
maximum execution time (i.e. the watchdog) declared 
in the task properties.

0 no yes

%S12
PLCRUNNING

PLC in 
RUN

This bit is set to 1 by the system when the PLC is in 
RUN.
It is set to 0 by the system as soon as the PLC is no 
longer in RUN (STOP, INIT, etc.).

0 no yes

%S13
1RSTSCANRUN

first cycle 
after 
switching to 
RUN

Normally set to 0, this is set to 1 by the system during 
the first cycle of the master task after the PLC is set to 
RUN.

- no yes

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

WARNING
UNINTENDED EQUIPMENT OPERATION

On Quantum Safety PLCs, communication interruptions from NOE, CRA or CRP 
modules are not reported on bit %S10.

Make certain that these system bits are used correctly.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Description of the System Bits %S15 to %S21

Detailed Description

NOTE: Not all of the system bits can be used in the Quantum Safety PLC. The 
unusable system bits are marked in the Quant. Safety column with no.

The following table gives a description of the system bits %S15 to %S21:

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%S15
STRINGERROR

character 
string fault

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

0 yes no

%S16
IOERRTSK

task 
input/output 
fault

Normally set to 1, this bit is set to 0 by the system when 
a fault occurs on an in-rack I/O module or a Fipio device 
configured in the task.
This bit must be reset to 1 by the user. 

1 yes yes

%S17
CARRY

rotate or 
shift output

normally at 0
During a rotate or shift operation, this bit takes the state 
of the outgoing bit.

0 no yes

%S18
OVERFLOW

overflow or 
arithmetic 
error

Normally set to 0, this bit is set to 1 in the event of a 
capacity overflow if there is

a result greater than + 32 767 or less than - 32 768, 
in single length,
result greater than + 65 535, in unsigned integer,
a result greater than + 2 147 483 647 or less than - 
2 147 483 648, in double length,
result greater than +4 294 967 296, in double length 
or unsigned integer,
real values outside limits,
division by 0,
the root of a negative number,
forcing to a non-existent step on a drum,
stacking up of an already full register, emptying of 
an already empty register.

It must be tested by the user program after each 
operation where there is a risk of overflow, and then 
reset to 0 by the user if there is indeed an overflow.
When the %S18 bit switches to 1, the application stops 
in error state if the %S78 bit has been set to 1.

0 yes yes
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%S19
OVERRUN

task period 
overrun 
(periodical 
scanning)

Normally set to 0, this bit is set to 1 by the system in the 
event of a time period overrun (i.e. task execution time 
is greater than the period defined by the user in the 
configuration or programmed into the %SW word 
associated with the task). The user must reset this bit to 
0. Each task manages its own %S19 bit.

0 yes yes

%S20
INDEXOVF

Index 
overflow

Normally set to 0, this bit is set to 1 when the address 
of the indexed object becomes less than 0 or exceeds 
the number of objects declared in the configuration.
In this case, it is as if the index were equal to 0.
It must be tested by the user program after each 
operation where there is a risk of overflow, and then 
reset to 0 if there is indeed an overflow. 
When the %S20 bit switches to 1, the application stops 
in error state if the %S78 bit has been set to 1.

0 yes no

%S21
1RSTTASKRUN

first task 
cycle

Tested in a task (Mast, Fast, Aux0, Aux1, Aux2 Aux3), 
the bit %S21 indicates the first cycle of this task. %S21 
is set to 1 at the start of the cycle and reset to zero at 
the end of the cycle.
Notes: The bit %S21 does not have the same meaning 
in PL7 as in Unity Pro.

0 no yes

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

WARNING
UNINTENDED EQUIPMENT OPERATION

On Quantum Safety PLCs, communication interruptions from NOE, CRA or CRP 
modules are not reported on bit %S16.

Make certain that these system bits are used correctly.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Description of the System Bits %S30 to %S51

Detailed Description

NOTE: Not all of the system bits can be used in the Quantum Safety PLC. The 
unusable system bits are marked in the Quant. Safety column with no.

The following table gives a description of the system bits %S30 to %S51:

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%S30
MASTACT

activation/deactivation 
of the master task

see chapter "System Bits" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual

1 yes no

%S31
FASTACT

activation/deactivation 
of the fast task

see chapter "System Bits" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual

0 yes no

%S32
%S33
%S34
%S35

activation/deactivation 
of the auxiliary tasks 0-3

see chapter "System Bits" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual

0 yes no

%S38
ACTIVEVT

enabling/inhibition of 
events

see chapter "System Bits" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual

1 yes no

%S39
EVTOVR

saturation in event 
processing

see chapter "System Bits" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual

0 yes no

%S50
RTCWRITE

updating of time and 
date via words %SW50 
to %SW53

Normally set to 0, this bit is set to 1 by the 
program or the terminal:

set to 0: update of system words %SW50 to 
%SW53 by the date and time supplied by the 
PLC real-time clock,
set to 1: system words %SW50 to %SW53 
are no longer updated, therefore making it 
possible to modify them.
The switch from 1 to 0 updates the real-time 
clock with the values entered in words 
%SW50 to %SW53.

0 yes yes

%S51
RTCERR

time loss in real-time 
clock

This system-managed bit set to 1 indicates that 
the real-time clock is missing or that its system 
words (%SW50 to %SW53) are meaningless. If 
set to 1, the clock must be reset to the correct 
time.

- no yes
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Description of the System Bits %S59 to %S122

Detailed Description

NOTE: Not all of the system bits can be used in the Quantum Safety PLC. The 
unusable system bits are marked in the Quant. Safety column with no.

The following table gives a description of the system bits %S59 to %S122:

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%S59
RTCTUNING

incremental 
update of 
the time 
and date 
via word 
%SW59

Normally set to 0, this bit can be set to 1 or 0 by the 
program or the terminal:

set to 0: the system does not manage the system 
word %SW59,
set to 1: the system manages edges on word 
%SW59 to adjust the date and current time (by 
increment).

0 yes yes

%S67
PCMCIABAT0

state of the 
application 
memory 
card battery

This bit is used to monitor the status of the main battery 
when the memory card is in the upper PCMCIA slot (all 
the Atriums, Premiums, and on the Quantums):

set to 1: main voltage battery is low (application is 
preserved but you must replace the battery following 
the so-called predictive maintenance procedure),
set to 0: main battery voltage is sufficient 
(application is preserved).

Bit %S67 is managed:
on the PV06 small and medium capacity RAM 
memory cards (product version written on the card 
label), i.e. offering memory size under Unity 
=#768K: TSX MRP P 128K, TSX MRP P 224K TSX 
MCP C 224K, MCP C 512K, TSX MRP P 384K, TSX 
MRP C 448K, TSX MRP C 768K,
under Unity whose version is ≥ 2.02.

- no yes

%S68
PLCBAT

state of the 
processor 
battery

This bit is used to check the operating state of the 
backup battery for saving data and the program in 
RAM:

set to 0: battery present and operational,
set to 1: battery missing or non-operational.

– no yes

%S75
PCMCIABAT1

state of the 
data 
storage 
memory 
card battery

This bit is used to monitor the status of the main battery 
when the memory card is in the lower PCMCIA slot, see 
chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual.
Note: Data stored on a memory card in slot B are not 
processed in SIL3 projects.

– no no
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%S76
DIAGBUFFCONF

configured 
diagnostics 
buffer

This bit is set to 1 by the system when the diagnostics 
option has been configured. Then, a diagnostics buffer 
for storage of errors found by diagnostics DFBs is 
reserved. 
This bit is read-only.

0 no yes

%S77
DIAGBUFFFULL

full 
diagnostics 
buffer

This bit is set to 1 by the system when the buffer that 
receives errors from the diagnostics function blocks is 
full.
This bit is read-only.

0 no yes

%S78
HALTIFERROR

stop in the 
event of 
error

Normally at 0, this bit can be set to 1 by the user, to 
program a PLC stop on application fault: %S15, %S18, 
%20.

0 yes yes

%S80
RSTMSGCNT

reset 
message 
counters

Normally set to 0, this bit can be set to 1 by the user to 
reset the message counters %SW80 to %SW86.

0 yes yes

%S94
SAVECURRVAL

saving 
adjustment 
values

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

0 yes no

%S118
REMIOERR

General 
Remote I/O 
fault

Normally set to 1, this bit is set to 0 by the system when 
a fault occurs on a device connected to the RIO (Fipio 
for Premium or Drop S908 for Quantum) remote 
input/output bus.
 This bit is reset to 1 by the system when the fault 
disappears.
This bit is not updated if an error occurs on the other 
buses (DIO, ProfiBus, ASI).

– no yes

%S119
LOCIOERR

General 
inrack I/O 
fault

Normally set to 1, this bit is set to 0 by the system when 
a fault occurs on an I/O module placed in 1 of the racks.
This bit is reset to 1 by the system when the fault 
disappears.

– no yes

%S120
%S121
%S122

DIO bus 
faults

see chapter "System Bits" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the 
Unity Pro Program Languages and Structure 
Reference Manual

– no no

Bit
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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B.2 System Words

Introduction

This section describes the system words of the Quantum Safety PLC. 

For your convenience, all system words of standard Quantum PLCs are listed but 
only explained further if used in the Quantum Safety PLC.

What Is in This Section?

This section contains the following topics:

Topic Page

Description of the System Words %SW0 to %SW21 110

Description of the System Words %SW30 to %SW59 113

Description of the System Words %SW60 to %SW127 117
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Description of the System Words %SW0 to %SW21

Detailed Description

NOTE: Not all of the system words can be used in the Quantum Safety PLC. The 
unusable system words are marked in the Quant. Safety column with no.

The following table gives a description of the system words %SW0 to %SW21:

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%SW0
MASTPERIOD

master task 
scanning 
period

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 yes no

%SW1
FASTPERIOD

fast task 
scanning 
period

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 yes no

%SW2, %SW3, 
%SW4, %SW5

auxiliary task 
scanning 
period

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 yes no

%SW8
TSKINHIBIN

acquisition of 
task input 
monitoring

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 yes no

%SW9
TSKINHIBOUT

monitoring of 
task output 
update

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 yes no

%SW10
TSKINIT

first cycle 
after cold 
start

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 no no

%SW11
WDGVALUE

watchdog 
duration

Reads the duration of the watchdog. The duration 
is expressed in milliseconds (20...990 ms). 
This word cannot be modified.

- no yes
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%SW12
APMODE

mode of 
application 
processor

This word indicates the operating mode of the 
application processor. Possible values are:

16#A501: application processor is in 
Maintenance Mode.
16#5AFE: application processor is in Safety 
Mode.

Any other value is interpreted as an error.
This system word is not available for the standard 
Quantum CPU.

16#A501 no yes

%SW13
INTELMODE

mode of Intel 
processor

This word indicates the operating mode of the Intel 
Pentium processor. Possible values are:

16#501A: application processor is in 
Maintenance Mode.
16#5AFE: application processor is in Safety 
Mode.

Any other value is interpreted as an error.
This system word is not available for the standard 
Quantum CPU.

16#501A no yes

%SW14
OSCOMMVERS

commercial 
version of 
PLC 
processor

This word contains the commercial version of the 
PLC processor.
Example: 16#0135
version: 01; issue number: 35

- no yes

%SW15
OSCOMMPATCH

PLC 
processor 
patch version

This word contains the commercial version of the 
PLC processor patch.
It is coded onto the least significant byte of the 
word.
coding: 0 = no patch, 1 = A, 2 = B...
Example: 16#0003 corresponds to patch C.

- no yes

%SW16
OSINTVERS

firmware 
version 
number

This word contains the Firmware version number 
in hexadecimal of the PLC processor firmware.
Example: 16#0017
version: 2.1; VN: 17

- no yes

%SW17
FLOATSTAT

error status 
on floating 
operation

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual
%SW17.1: Flag not managed by Quantum Safety.

0 yes yes

%SW18
%SW19
100MSCOUNTER

absolute time 
counter

%SW18 is the low and %SW19 the high word for 
calculating durations. Both are incremented every 
1/10th of a second by the system (even when the 
PLC is in STOP, they are no longer incremented if 
it is powered down). They can be read and written 
by the user program or by the terminal.

0 yes yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
33003885 07/2012 111



System Objects
%SW20
%SW21
MSCOUNTER

absolute time 
counter

The low word %SW20 and the high word %SW21 
are incremented every 1/1000th of a second by 
the system (even when the PLC is in STOP, they 
are no longer incremented if it is powered down). 
They can be read by the user program or by the 
terminal. %SW20 and %SW21 are reset on a cold 
start, but not on a warm start.

0 no yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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Description of the System Words %SW30 to %SW59

Detailed Description

NOTE: Not all of the system words can be used in the Quantum Safety PLC. The 
unusable system words are marked in the Quant. Safety column with no.

The following table gives a description of the system words %SW30 to %SW59:

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%SW30
MASTCURRTIME

master task 
execution time

This word indicates the execution time of the last 
master task cycle (in ms).

- no no

%SW31
MASTMAXTIME

maximum 
master task 
execution time

This word indicates the longest master task 
execution time since the last cold start (in ms).

- no yes

%SW32
MASTMINTIME

minimum 
master task 
execution time

This word indicates the shortest master task 
execution time since the last cold start (in ms).

- no yes

%SW33 to 
%SW35

fast task 
execution 
times

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

- no no

%SW36 NTP number of 
seconds (LSB)

This word indicates the number of seconds 
passed since January 1st, 1980 at 00:00 (LSB 
part). It reflects the NTP time coming from the 
140 NOE 771 11 module. This word is refreshed 
internally between two NTP synchronizations.

0 no yes

%SW37 NTP number of 
seconds 
(MSB)

This word indicates the number of seconds 
passed since January 1st, 1980 at 00:00 (MSB 
part). It reflects the NTP time coming from the 
140 NOE 771 11 module. This word is refreshed 
internally between two NTP synchronizations.

0 no yes

%SW38 NTP number of 
milliseconds

This word indicates the number of milliseconds 
added to the NTP number of seconds (%SW36 
and %SW37). It reflects the NTP time coming 
from the 140 NOE 771 11 module. This word is 
refreshed internally between two NTP 
synchronizations.

0 no yes
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%SW39 status of the 
NTP 
timestamps in 
ms

Meaning of the different bits of %SW39 word:
%SW39.0 (managed by the controller):

=0, the time value is not available or the 
time has not been updated within last 2 
minutes
=1, the time value is available or the time 
has been updated within last 2 minutes

%SW39.1 (managed by the 140 NOE 771 11 
status):

=0, the NTP server time value is not 
available
=1, the updated time value is received from 
the NTP server and has been sent to the 
module (at least once)

%SW39.2 (managed by the CPU):
=0, the time value in %SW36 to %SW38 
words differs from the last NTP server time 
received by more than 2 seconds. The last 
NTP server time received has been 
ignored.
=1, the time value in %SW36 to %SW38 
words are consistent with the last NTP 
server time received (less than 2 seconds 
difference). The time value in %SW36 to 
%SW38 words is filtered with a slope of 
1ms/s to reach the last NTP server time 
received.

%SW39.3 to %SW39.7: not used
%SW39.8 (control that can be set by the 
application):

=0, no action
=1. When set to 1, the CPU will accept the 
next NTP server time received without 
filtering (1 ms/s) and without consistency 
check (difference between time value in 
%SW36 to %SW38 words and NTP server 
time). After the next NTP server time is 
received, the %SW39.8 bit is automatically 
reset to 0 by the controller.

%SW39.9 to %SW39.15: not used

0 yes yes

%SW40 to 
%SW47

auxiliary tasks 
execution 
times

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

- no no

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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%SW48
IOEVTNB

number of 
events

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages and 
Structure Reference Manual

0 yes no

%SW49
DAYOFWEEK

%SW50
SEC

%SW51
HOURMIN

%SW52
MONTHDAY

%SW53
YEAR

real-time clock 
function

System words containing date and current time (in 
BCD):

%SW49: day of the week:
1 = Monday,
2 = Tuesday,
3 = Wednesday,
4 = Thursday,
5 = Friday,
6 = Saturday,
7 = Sunday,

%SW50: Seconds (16#SS00),
%SW51: Hours and Minutes (16#HHMM),
%SW52: Month and Day (16#MMDD),
%SW53: Year (16#YYYY).

These words are managed by the system when 
the bit %S50 is set to 0.
These words can be written by the user program 
or by the terminal when the bit %S50 is set to 1.

- yes yes

%SW54
STOPSEC

%SW55
STOPHM

%SW56
STOPMD

%SW57
STOPYEAR

%SW58
STOPDAY

real-time clock 
function on last 
stop

System words containing date and time of the last 
power outage or PLC stop (in Binary Coded 
Decimal):

%SW54: Seconds (00SS),
%SW55: Hours and Minutes (HHMM),
%SW56: Month and Day (MMDD),
%SW57: Year (YYYY),
%SW58: the most significant byte contains the 
day of the week (1 for Monday through to 7 for 
Sunday), and the least significant byte 
contains the code for the last stop:

1 = change from RUN to STOP by the 
terminal or the dedicated input,
2 = stop by watchdog (PLC task or SFC 
overrun),
4 = power outage or memory card lock 
operation,
5 = stop on hardware fault,
6 = stop on software fault. Details on the 
type of software fault are stored in 
%SW125.

- no yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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%SW59
ADJDATETIME

adjustment of 
current date

Contains 2 8-bit series to adjust the current date.
The action is performed on the rising edge of the 
bit.
This word is enabled by bit %S59=1.
In the following illustration, bits in the left column 
increment the value, and bits in the right column 
decrement the value:

0 yes yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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Description of the System Words %SW60 to %SW127

Detailed Description

NOTE: Not all of the system words can be used in the Quantum Safety PLC. The 
unusable system words are marked no in the Quant. Safety column.

The following table gives a description of the system words %SW60 to %SW127:

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety

%SW60
HSB_CMD

Quantum Hot 
Standby 
command 
register

Meaning of the different bits of the word %SW60:
%SW60.0=1 invalidates the commands 
entered in the display (keypad).
%SW60.1

=0 sets PLC A to OFFLINE mode.
=1 sets PLC A to RUN mode.

%SW60.2
=0 sets PLC B to OFFLINE mode.
=1 sets PLC B to RUN mode.

%SW60.3=0 forces Standby PLC to OFFLINE 
mode if the applications are different.
%SW60.4

=0 authorizes an update of the firmware 
only after the application has stopped.
=1 authorizes an update of the firmware 
without the application stopping.

%SW60.5=1 application transfer request from 
the Standby to the primary.
%SW60.8

=0 address switch on Modbus port 1 during 
a primary swap.
=1 no address switch on Modbus port 1 
during a primary swap.

0 yes no
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%SW61
HSB_STS

Quantum status 
register

Meaning of the different bits of the word %SW61:
%SW61.0 und %SW61.1 PLC operating mode 
bits:

%SW61.1=0, %SW61.0=1: OFFLINE 
mode.
%SW61.1=1, %SW61.0=0: primary mode.
%SW61.1=1, %SW61.0=1: secondary 
mode (Standby).

%SW61.2 and %SW61.3 operating mode bits 
from the other PLC

%SW61.3=0, %SW61.2=1: OFFLINE 
mode.
%SW61.3=1, %SW61.2=0: primary mode.
%SW61.3=1, %SW61.2=1: secondary 
mode (Standby).
%SW61.3=0, %SW61.2=0: the remote PLC 
is not accessible (switched off, no 
communication).

%SW61.4=0 the applications are identical on 
both PLCs.
%SW61.5

=0 the PLC is used as unit A.
=1 the PLC is used as unit B.

%SW61.7
=0 same PLC OS version.
=1 different PLC OS version.

%SW61.8
=0 same Copro OS version.
=1 different Copro OS version.

%SW61.12
=0 information given by bit 13 is not 
relevant.
=1 information given by bit 13 is valid.

%SW61.13
=0 NOE address set to IP.
=1 NOE address set to IP + 1.

%SW61.15
=0 Hot Standby not activated.
=1 Hot Standby activated.

0 no yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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%SW62
HSBY_REVERSE0
%SW63
HSBY_REVERSE1

transfer word These 2 words may be written by the user in the 
first section of the master task. They are then 
transferred automatically from the Standby 
processor to update the primary PLC.
They may be read on the primary PLC and be 
used as primary application parameters.

0 yes yes

%SW70
WEEKOFYEAR

real-time clock 
function

System word containing the number of the week 
in the year: 1 to 52.

– yes

%SW71
KEY_SWITCH

position of the 
switches on the 
Quantum front 
panel

This word provides the image of the positions of 
the switches on the front panel of the Quantum 
processor. This word is updated automatically by 
the system.

%SW71.0 = 1 switch in the "Memory 
protected" position,
%SW71.1 = 1 switch in the "STOP" position,
%SW71.2 = 1 switch in the "START" position,
%SW71.8 = 1 switch in the "MEM" position,
%SW71.9 = 1 switch in the "ASCII" position,
%SW71.10 = 1 switch in the "RTU" position,
%SW71.3 to 7 and 11 to 15 are not used.

0 no yes

%SW75
TIMEREVTNB

timer-type 
event counter

see chapter "System Objects" (see Unity Pro, 
Program Languages and Structure, Reference 
Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual

0 no

%SW76
DLASTREG

diagnostics 
function: 
recording

Result of the last registration:
= 0 if the recording was successful,
= 1 if the diagnostics buffer has not been 
configured,
= 2 if the diagnostics buffer is full.

0 yes

%SW77
DLASTDEREG

diagnostics 
function: non-
recording

Result of the last deregistration:
= 0 if the non-recording was successful,
= 1 if the diagnostics buffer has not been 
configured,
= 21 if the error identifier is invalid,
= 22 if the error has not been recorded.

0 yes

%SW78
DNBERRBUF

diagnostics 
function: 
number of 
errors

Number of errors currently in the diagnostics 
buffer.

0 yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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%SW80
MSGCNT0

%SW81
MSCNT1

message 
management

These words are updated by the system, and can 
also be reset using %S80.

%SW80: Number of Modbus messages sent by 
the system as client on all communication 
ports except USB and Ethernet copro.

NOTE: Modbus messages sent by the system as 
Master are not counted in this word.

%SW81: Number of Modbus messages 
received by the system as client on all 
communication ports except USB and 
Ethernet copro.

NOTE: Modbus messages received as response 
to the requests sent by the system, as Master, are 
not counted in this word.

0 yes yes

%SW87
MSTSERVCNT

communication 
flow 
management

Number of requests processed by synchronous 
server per master (MAST) task cycle.

0 yes

%SW90
MAXREQNB

maximum 
number of 
requests 
processed per 
master task 
cycle 

This word is used to set a maximum number of 
requests which can be processed by the PLC per 
master task cycle. 
When the CPU is the server: This number of 
requests must be between 2 (minimum) and N+4 
(maximum). 
N: number differs depending on the model.
When the CPU is the client: 
N: number differs depending on the model.
The value 0 does not work. If a value that is 
outside of the range is entered, it is the value N 
that is taken into account.
See also chapter "System Objects" (see Unity 
Pro, Program Languages and Structure, 
Reference Manual ) in the Unity Pro Program 
Languages and Structure Reference Manual.

0 yes yes

%SW108
FORCEDIOIM

number of 
forced I/O 
module bits

This system word counts the number of forced I/O 
module bits. This word is incremented for every 
forcing, and decremented for every unforcing.

0 no yes

%SW110 number of 
unrestricted 
memory area 
for %M

This system word gives information on the size of 
the unrestricted memory area for %M.
This system word is not available for the standard 
Quantum CPU.

– no yes

%SW111 number of 
unrestricted 
memory area 
for %MW

This system word gives information on the size of 
the unrestricted memory area for %MW.
This system word is not available for the standard 
Quantum CPU.

– no yes

Word
Symbol
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State

Write 
Access

Quant. 
Safety
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%SW124
CPUERR

type of system 
fault

This system word is updated if the PLC is set to 
error state.
The possible values are as follows:

0x0065: execution of HALT instruction 
impossible
0x0080: system watchdog

If the PLC is set to Safety error state, the content 
of %SW125 is updated and can be read after the 
next restart of the PLC (see below).

– no yes

Word
Symbol

Function Description Initial 
State

Write 
Access

Quant. 
Safety
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%SW125
BLKERRTYPE

last fault 
detected

The code of the last fault detected is given in this 
word. The following error codes cause the PLC to 
stop if %S78 is set to 1. %S15, %S18 and %S20 are 
activated independently of %S78:

16#0002: PCMCIA signature not verified
16#2258: execution of HALT instruction
16#2302: call to a not supported system 
function in a user function block
16#9690: error of application CRC detected in 
background
16#DE87: calculation error on floating-point 
numbers (%S18, these errors are listed in the 
word %SW17)
16#DEB0: watchdog overflow (%S11)
16#DEF1: character string transfer error 
(%S15)
16#DEF2: arithmetic or division by 0 error 
(%S18) 
16#DEF3: index overflow (%S20)

Note: The codes 16#8xxx and 16#7xxx do not 
stop the application and indicate an error on 
function blocks.
In case of a SIL3 related error, the PLC stops. 
After power off and restart of the PLC, %SW 125 
contains the code of the cause of the error:

0x5AF1: sequence check error (unpredictable 
execution in CPU)
0x5AF2: error in memory (corrupt address)
0x5AF3: comparison error (execution results 
of Intel and application processor differ)
0x5AF4: real-time clock error
0x5AF5: error initializing double code 
execution
0x5AF6: watchdog activation error
0x5AF7: error during memory check (takes 
more than 8 hours)
0x5AF8: error in memory check (corrupt RAM)

Note: %SW125 is only reset after init or 
complete download or restart (it always contains 
the last fault detected).

– no yes

Word
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State
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Safety
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For the description of the system words %SW128 to %SW339 and %SW535 to %SW640, 
see the chapter "Quantum Specific System Words" (see Unity Pro, Program 
Languages and Structure, Reference Manual ) in the Unity Pro Program Languages 
and Structure Reference Manual. The system words %SW340 to %SW534 are not 
used in Quantum Safety PLCs.

%SW126
ERRADDR0
%SW127
ERRADDR1

blocking fault 
instruction 
address

Address of the instruction that generated the 
application blocking fault. 
For 16 bit processors:

%SW126 contains the offset for this address,
%SW127 contains the segment number for this 
address.

For 32 bit processors:
%SW126 contains the least significant word for 
this address,
%SW127 contains the most significant word for 
this address.

The content of %SW126 and %SW127 is for 
Schneider Electric use only.

0 no yes

Word
Symbol
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State

Write 
Access

Quant. 
Safety
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Glossary
0-9

!
NOTE: For terms taken from the IEC 61508 standard, refer to the standard for 
complete definitions.

1002D diagnostic configuration
X out of Y

For example 1 out of 2. Voting and redundancy capacity of a Safety-Related 
System.

D in 1oo2D refers to diagnostics. Hence, D in 1oo2D means 1 out of 2 with 
diagnostics.

A

ALARP
as low as is reasonably practicable

(Definition IEC 61508)
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C

CCF
common cause failure

failure, which is the result of 1 or more events, causing coincident failures of 2 or 
more separate channels in a multiple channel system, leading to system failure

(Definition IEC 61508)

The common cause factor in a dual channel system is the crucial factor for the 
probability of failure on demand (PFD) for the whole system.

cold start
Cold start refers to starting the computer from power off.
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CPU
central processing unit

CRC
cyclic redundancy check

D

DC
diagnostic coverage

fractional decrease in the probability of dangerous hardware failures resulting from 
the operation of the automatic diagnostic tests

(Definition IEC 61508)

The fraction of the possible dangerous failures λD is divided into failures which are 
detected by diagnostics and failures which remain undetected.

λD=λDD + λDU

The diagnostic coverage (DC) defines the fraction of the dangerous failures which 
are detected.

λDD =λD. DC

λDU=λD (1 - DC)

The definition may also be represented in terms of the following equation, where DC 
is the diagnostic coverage, λDD is the probability of detected dangerous failures and 
λD total is the probability of total dangerous failures:

DDT
derived data type

A derived data type is user defined. 

DFB
derived function block
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DIO
distributed input/output

DLL
dynamic link library

E

E/E/PES
electrical/electronic/programmable electronic system

(Definition IEC 61508)

System for control, protection or monitoring based on 1 or more electrical/electronic 
programmable electronic (E/E/PE) devices. This includes elements of the system 
such as power supplies, sensors and other input devices, data highways and other 
communication paths, and actuators and other output devices.

EDT
elementary data type

An elementary data type is predefined.

EF
elementary function

EFB
elementary function block

EMC
electromagnetic compatibility

The term refers to the origin, control, and measurement of electromagnetic effects 
on electronic systems.

EN
European Norm

This is the official European standard.
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error
discrepancy between a computed, observed or measured value or condition and the 
true, specified or theoretically correct value or condition

(Definition IEC 61508)

ESD
emergency shutdown

EUC
equipment under control

(Definition IEC 61508)

This term designates equipment, machinery, apparatuses or plants used for 
manufacturing, process, transportation, medical or other activities. 

F

failure
termination of the ability of a functional unit to perform a required function

(Definition IEC 61508)

fault
abnormal condition that may cause a reduction in, or loss of, the capability of a 
functional unit to perform a required function

(Definition IEC 61508)

FBD
functional block diagram

This is an IEC 61131-3 programming language for PLC user logic.

FFB
function/function block

FMEA
failure modes and effects analysis
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FMECA
failure modes and effects criticality analysis

Functional Safety
part of the overall safety relating to the EUC and the EUC control system which 
depends on the correct functioning of the E/E/PE safety-related systems, other 
technology safety-related systems and external risk reduction facilities

(Definition IEC 61508)

A system is defined functionally Safe if random, systematic and common cause 
failures do not lead to malfunctioning of the system and do not result in injury or 
death of humans, spills to the environment and loss of equipment or production:

Functional Safety deals with the part of the overall Safety that depends on the 
correct functioning of the Safety-Related System.
Functional Safety applies to products as well as organizations.

H

HALT
high accelerated life tests

HFT
hardware fault tolerance

(Definition IEC 61508)

A hardware fault tolerance of N means that N + 1 faults could cause a loss of the 
Safety Function, for instance:

HFT = 0: The 1st failure could cause a loss of the Safety Function

HFT = 1: 2 faults in combination could cause a loss of the Safety Function. (There 
are 2 different paths to go to a Safe state. Loss of the Safety Function means that 
a Safe state cannot be entered.

HMI
human-machine interface

HSBY
Hot Standby
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I

IEC
International Electrotechnical Commission

IEC 61508
The IEC 61508 standard is an international standard that addresses Functional 
Safety of electrical / electronic / programmable electronic Safety-Related Systems. 
It applies to any kind of Safety-Related System in any industry wherever there are 
no product standards.

IL
instruction list

This is an IEC 61131-3 programming language for PLC user logic.

L

LCD
liquid crystal display

LD
ladder diagram

This is an IEC 61131-3 programming language for PLC user logic.

M

MTBF
mean time between failures

MTTF
mean time to failure

MTTR
mean time to repair
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N

NFPA
National Fire Protection Association

This is a body for establishing codes and standards for fire protection, electrical and 
machine Safety in the U.S.

non-interfering module
Non-interfering modules are modules that are not directly used to control the Safety 
Function. They do not interfere with the Safety modules (either during normal 
operation or if there is a fault).

NTP
Network Time Protocol

P

PELV
protected extra low voltage

PES
programmable electronic system

(Definition IEC 61508)

System for control, protection or monitoring based on 1 or more programmable 
electronic devices, including elements of the system such as power supplies, 
sensors and other input devices, data highways and other communication paths, 
and actuators and other output devices.

PES is another term for a computer control system or PLC.
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PFD
probability of failure on demand

(Definition IEC 61508)

For a single channel system the average probability of a failure on demand is 
calculated as follows:

For a dual channel system the average probability of a failure on demand is 
calculated as follows:

For a dual channel system, also the Common Cause effect (CC) must be 
considered. The common cause effect ranges from 1% to 10% of PFDCH1 and 
PFDCH2. (=1/RRF).

PFH
probability of failure per hour

(Definition IEC 61508)

PLC
programmable logic controller

project
A project is a user application in Unity Pro XLS.

proof test
periodic test performed to detect failures in a safety-related system so that, if 
necessary, the system can be restored to an "as new" condition or as close as 
practical to this condition

(Definition IEC 61508)

proof test interval
The proof test interval is the time period between proof tests.
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PRT
PLC reaction time

The PLC Reaction Time is the time which passes between a signal is detected at 
the input module terminal and the reaction is set at the output module terminal. 

PS
power supply

PST
process safety time

The process safety time is defined as the period of time between a failure occurring 
in EUC or the EUC control system (with the potential to give rise to a hazardous 
event) and the occurrence of the hazardous event if the safety function is not 
performed.

(Definition IEC 61508)

Q

QSE
environment system qualification

R

RAM
random access memory

random hardware failure
failure, occurring at a random time, which results from 1 or more of the possible 
degradation mechanisms in the hardware

(Definition IEC 61508)

RIO
remote input/output
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risk
combination of the probability of occurrence of harm and the severity of that harm

(Definition IEC 61508)

Risk is calculated using the following equation: R=S*H

The letters stand for: 

RM
requirements management

RRF
risk reduction factor

(Definition IEC 61508)

The risk reduction factor equals 1/PFD.
[

Letter Meaning

R risk

S extent of the damage

H frequency of occurrence of the damage
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RTC
real-time clock

S

Safety Function
function to be implemented by an E/E/PE safety-related system, other technology 
safety-related system or external risk reduction facilities, which is intended to 
achieve or maintain a safe state for the EUC, in respect of a specific hazardous 
event

(Definition IEC 61508)

Safety Integrity
probability of a safety-related system satisfactorily performing the required safety 
functions under all the stated conditions within a stated period of time

(Definition IEC 61508)

Safety PLC
Quantum Safety PLC (140 CPU 651 60S or 140 CPU 671 60S)

Safety variable
variable used to implement a Safety Function in a Safety-Related System

Safety-Related System
This term designates a system that both

implements the required Safety Functions necessary to achieve or maintain a 
Safe state for the EUC and
is intended to achieve, on its own or using other E/E/PE Safety-Related Systems, 
other technology Safety-Related Systems, or external risk reduction facilities, the 
necessary Safety Integrity for the required Safety Functions.

SFC
sequential function chart

This is an IEC 61131-3 programming language for PLC user logic.

SFF
safe failure fraction
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SFR
Safety Functional requirement

Safety Functional requirements are derived from the hazard analysis and define 
what the function does, for instance the Safety Function to be performed.

SIL
NOTE: For complete definitions and parameters related to SIL ratings refer to 
IEC 61508, "Functional safety of electrical/electronic/programmable electronic 
safety related systems". Provided here is a partial definition.

safety integrity level

discrete level (1 out of a possible 4) for specifying the safety integrity requirements 
of the safety functions to be allocated to the E/E/PE safety-related systems, where 
safety integrity level 4 has the highest level of safety integrity and safety integrity 
level 1 has the lowest

(Definition IEC 61508)

SIL2 project (application)
A project (application) that uses a Quantum Safety PLC (140 CPU 651 60S V1.00 
or 140 CPU 671 60S V1.00) to implement Safety Functions in a Safety-Related 
System.

SIL3 project (application)
A project (application) that uses a Quantum Safety PLC (140 CPU 651 60S V2.00 
or 140 CPU 671 60S V2.00) to implement Safety Functions in a Safety-Related 
System.

SIR
Safety Integrity requirement

Safety Integrity requirements are derived from a risk assessment and describe the 
likelihood of a Safety Function to be performed satisfactorily, for instance the degree 
of certainty necessary for the Safety Function to be carried out.

sniffing
reading the configuration out of a PLC
33003885 07/2012 137



Glossary
SRS
safety requirements specification

specification containing all the requirements of the safety functions that have to be 
performed by the safety-related systems

(Definition IEC 61508)

SSC
system Safety concept

This is a detailed description of the system architecture, configuration and 
diagnostics required to achieve Functional Safety.

ST
structured text

This is an IEC 61131-3 programming language for PLC user logic.

Statement of Consequence
This is the last line within all special messages. It begins with "Failure to follow 
these instructions..."

systematic failure
failure related in a deterministic way to a certain cause, which can only be eliminated 
by a modification of the design or of the manufacturing process, operational 
procedures, documentation or other relevant factors

(Definition IEC 61508)

T

TÜV
Technischer Überwachungsverein

(German for Association for Technical Inspection)
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U

UMA
unrestricted memory area

It is a specially dedicated memory area for bits and words which is not write 
protected.

V

VDE
Verband Deutscher Elektroingenieure

This is the German equivalent of the IEEE.

W

warm start
Warm start refers to restarting the computer without turning the power off.
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module definition, 72
%S0, 102
%S1, 102
%S10, 103
%S11, 103
%S118, 108
%S119, 108
%S12, 103
%S120, 108
%S121, 108
%S122, 108
%S13, 103
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%S16, 104
%S17, 104
%S18, 104
%S19, 105
%S20, 105
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%S59, 107
%S6, 102
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%S68, 107
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%S75, 107
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%S77, 108
%S78, 108
%S80, 108
%S94, 108
%SW0, 110
%SW1, 110
%SW10, 110
%SW11, 110
%SW12, 111
%SW13, 111
%SW14, 111
%SW15, 111
%SW16, 111
%SW17, 111
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%SW4, 110
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%SW48, 115
%SW49, 115
%SW5, 110
%SW50, 115
%SW51, 115
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%SW53, 115
%SW54, 115
%SW55, 115
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%SW57, 115
%SW58, 115
%SW59, 116
%SW8, 110
%SW81, 120
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100MSCOUNTER, 111
1RSTSCANRUN, 103
1RSTTASKRUN, 105

A
access rights security management

Unity Pro XLS Software, 14
ACTIVEVT, 106
ADJDATETIME, 116
APMODE, 111
application password request

Unity Pro XLS Software, 47
application protection

Unity Pro XLS Software, 44
auto-lock 

Unity Pro XLS Software, 46
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B
BLKERRTYPE, 122
busses

Unity Pro XLS, 73

C
capabilities

Unity Pro XLS Software, 11
CARRY, 104
changing the password

Unity Pro XLS Software, 44
clear password

Unity Pro XLS Software, 46
cold start

Unity Pro XLS Software, 87
COLDSTART, 102
configuration with Unity Pro XLS Software

Quantum processors, 75
configuring I/O modules

Unity Pro XLS Software, 80
configuring network restrictions

Quantum safety PLCs Unity Pro XLS 
Software, 55
safety hardware Unity Pro XLS Software, 
55
Unity Pro XLS Software, 55

configuring restrictions
Unity Pro XLS, 72

configuring restrictions Unity Pro XLS
Quantum safety PLCs, 72
safety hardware, 72

connect to a safety PLC
Unity Pro XLS Software, 34

connecting to PLC Simulator
Unity Pro XLS Software, 36

CPUERR, 121
CRC error

maximum consecutive, 80
creating a safety project

Unity Pro XLS Software, 23
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D
data type, section restrictions

Quantum safety PLCs Unity Pro XLS 
Software, 61
safety hardware Unity Pro XLS Software, 
61
Unity Pro XLS Software, 61

data types
Unity Pro XLS Software, 60, 62

DAYOFWEEK, 115
DDT import

Unity Pro XLS Software, 60
DDTs

Unity Pro XLS Software, 62
debug screen PLC

Unity Pro XLS Software, 84
debugging the program

Unity Pro XLS Software, 83
definition Unity Pro XLS

safety modules, 72
delete password

Unity Pro XLS Software, 46
DFB import

Unity Pro XLS Software, 59
DFBs

Unity Pro XLS Software, 61
DIAGBUFFCONF, 108
DIAGBUFFFULL, 108
diagnostic DFB import

Unity Pro XLS Software, 59
diagnostic DFBs

Unity Pro XLS Software, 61
DIO field busses

Unity Pro XLS, 73
direct addresses

Unity Pro XLS Software, 63
DLASTDEREG, 119
DLASTREG, 119
DNBERRBUF, 119

E
ERRADDRi, 123
Ethernet network

Unity Pro XLS Software, 55, 56, 56
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event viewer (Microsoft Windows)
Unity Pro XLS Software, 20

EVTOVR, 106
expander

Unity Pro XLS, 73
extension racks

Unity Pro XLS, 73

F
FASTACT, 106
FASTPERIOD, 110
FBD/LD Import

Unity Pro XLS Software, 59
FFB import

Unity Pro XLS Software, 59
field busses 

Unity Pro XLS, 73
field busses DIO

Unity Pro XLS, 73
field busses RIO

Unity Pro XLS, 73
FLOATSTAT, 111
FORCEDIOIM, 120
forgot your password

Unity Pro XLS Software, 49
function block

S_SMOVE_BIT Unity Pro XLS Software, 
54

function block Unity Pro XLS Software
S_SMOVE_WORD, 54
safety, 54

G
general presentation

Unity Pro XLS Software, 11
global data service

Unity Pro XLS Software, 56

H
halt coil

Unity Pro XLS Software, 62
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halt EF
Unity Pro XLS Software, 62

HALTIFERROR, 108
HOURMIN, 115
HSB_CMD, 117
HSB_STS, 118
HSBY_REVERSEi, 119

I
I/O module sniffing

Unity Pro XLS, 73
I/O modules configuration

Unity Pro XLS Software, 80
I/O scanning service

Unity Pro XLS Software, 55
import of a project

Unity Pro XLS Software, 58
import partial

Unity Pro XLS, 74
Unity Pro XLS Software, 59

import restrictions
Unity Pro XLS Software, 59, 59

INDEXOVF, 105
info tab

Unity Pro XLS Software, 88
INTELMODE, 111
IOERR, 103
IOERRTSK, 104
IOEVTNB, 115

K
KEY_SWITCH, 119

L
language restrictions

Unity Pro XLS Software, 58
LD section restrictions

Unity Pro XLS Software, 62
LD/FBD Import

Unity Pro XLS Software, 59
located variables

Unity Pro XLS Software, 61, 61
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LOCIOERR, 108
loss of password

Unity Pro XLS Software, 49

M
maintenance mode

Unity Pro XLS Software, 29
MASTACT, 106
MASTCURRTIME, 113
MASTMAXTIME, 113
MASTMINTIME, 113
MASTPERIOD, 110
maximum consecutive CRC error, 80
MAXREQNB, 120
memory areas, unrestricted

Unity Pro XLS Software, 75
messaging service

Unity Pro XLS Software, 56
Modbus Plus network

Unity Pro XLS Software, 55
module definition

 Unity Pro XLS, 72
module sniffing

Unity Pro XLS, 73
modules Unity Pro XLS

non-interfering, 73
safety, 73

monitoring mode
Unity Pro XLS Software, 33

MONTHDAY, 115
MSGCNT0, 120
MSGCNT1, 120
MSTSERVCNT, 120

N
network configuration

Unity Pro XLS Software, 53
non-Interfering modules

Unity Pro XLS, 73
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O
opening a safety project

Unity Pro XLS Software, 25
OSCOMMPATCH, 111
OSCOMMVERS, 111
OSINTVERS, 111
output fallback

Unity Pro XLS Software, 87
OVERFLOW, 104
OVERRUN, 105

P
partial import

Unity Pro XLS, 74
Unity Pro XLS Software, 59

password changing
Unity Pro XLS Software, 44

password clear
Unity Pro XLS Software, 46

password delete
Unity Pro XLS Software, 46

password forgotten
Unity Pro XLS Software, 49

password lost
Unity Pro XLS Software, 49

password request
Unity Pro XLS Software, 47

PCMCIABAT0, 107
PCMCIABAT1, 107
Peer Cop service

Unity Pro XLS Software, 55
PLC debug screen

Unity Pro XLS Software, 84
PLC replacement

Unity Pro XLS, 74
PLC screen, info tab

Unity Pro XLS Software, 88
PLC screen, task tab

Unity Pro XLS Software, 85, 87
PLC simulator

Unity Pro XLS Software, 90
PLCBAT, 107
PLCRUNNING, 103
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Unity Pro XLS Software, 58
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